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Introduction to the Meazura™
MEZ1000 RDA



  (Introduction to the Meazura™ MEZ1000 RDA)

Part I
Introduction to the Meazura™

MEZ1000 RDA

With your Meazura™ MEZ1000 RDA, you'll be able to manage meetings and
appointments, remember people's names and personal details, and keep track of all the
items on your To Do List at both work and home.

You'll find it easy to start using the Meazura™ MEZ1000 RDA, become familiar with its
physical buttons and controls, and use HotSync®  technology to synchronize (exchange
and update) your Meazura™ MEZ1000 RDA and Palm Desktop. Once you familiarize
yourself with the basic workings of the Meazura™ MEZ1000 RDA, you'll easily be able to
do the following:
· Enter all your schedule details in the Date Book and view them by the day, week, or

month, and even set an alarm to remind you of an important event.
· Keep all your contact names, addresses, phone numbers, and other details in the

Address Book, so you can find them as soon as you need them.
· Add your tasks to the To Do List, prioritize them so you don't overlook them, and

assign them a due date.
· Ensure that you don't lose any of this important information simply by synchronizing

your data with Palm Desktop on your computer to create a backup copy.
· Customize your RDA and set different levels of security to prevent unauthorized users

from viewing your data.

System requirements for Windows

To install and operate Palm Desktop on Windows, your computer system must meet the
following requirements:
· Windows® 95 or later
· IBM-compatible 486 computer or higher
· 8 MB RAM (memory) minimum, 16 MB recommended (required with Windows NT

4.0)
· 20 MB available hard disk space
· CD-ROM drive (you can also download the Palm Desktop software from

http://www.aceeca.com/downloads)
· Mouse pointing device
· One available serial or USB port

Upgrade information

If you already own a Meazura™ MEZ1000 handheld, Aceeca recommends that you
install the version of Palm Desktop that comes with your new Meazura™ MEZ1000 RDA
into the same folder as your current Palm Desktop. All of your data is preserved when
you install the new version in the same folder as the previous version. If you use
another personal information manager (PIM), such as Microsoft Outlook, you still must
install the most recent HotSync Manager and conduit software from the Meazura™
Desktop CD that came with your new RDA.

You can perform HotSync® operations on your new device in exactly the same way as

http://www.aceeca.com/downloads


11

you did on your old device, allowing you to quickly synchronize your existing data with
your new RDA. Just remember to synchronize your old RDA with Palm Desktop before
you synchronize with your new RDA, so you have the latest information. When you
synchronize your new RDA for the first time, select the Desktop Overwrites Handheld
option for all the conduits. For more information, see
"Customizing HotSync application settings".

NOTE
If you used security features (for example, password protection) on your previous Meazura™
MEZ1000 RDA, you must upgrade to the most current version of Palm Desktop. The method of
storing passwords has changed with the latest release of Palm Desktop. Therefore, your password-
protected information will not be synchronized if you do not upgrade.

Upgrading your Palm Desktop Software

To upgrade Palm Desktop, follow the steps below:
1. Synchronize your old RDA with your old Palm Desktop to ensure that the latest

information from your RDA is on your desktop computer.
2. (Optional) To prevent data loss, go to the folder that stores Palm Desktop (for

example, C:\Program Files\Palm), copy the folder and its contents, rename it (for
example, Palm Backup), and store the copy outside the Palm Desktop folder.

3. Follow the installation instructions in "Installing Palm Desktop" later in this chapter.
Make sure you install the new software in the same folder as the old software.

4. To prepare for the first HotSync operation that will synchronize your new RDA with
your new Palm Desktop, go to the HotSync Manager and choose Custom.

NOTE
Select your username, if it does not already appear in the box.

5. For all conduits, click Change, and select the Desktop overwrites handheld option.
Then click OK. See "Customizing HotSync application settings" in Chapter 11 for
more information.

NOTE
For the conduits named, "Install", "Install Service Templates" and "Install To Card", Desktop
overwrites handheld is not an option. These should remain Enabled.

6. Connect your new RDA with the communications cable or in the cradle and press
the HotSync button. For more information on how to do this refer to your Quick
Start Guide included in your kit. If the Select User dialog box appears on your
desktop computer, select your username.

Maintaining a unique name for each RDA

After you complete the upgrade process described above, you will have two RDA's with the same
name. This is undesirable. Each RDA must have a unique name in order to prevent complications and
unexpected results during HotSync® operations.

We strongly recommend that you perform a hard reset on your old RDA as discussed in the next
section.
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Resetting your RDA

You should reset your RDA after completing the upgrade process. You may also have to
perform a reset if your RDA no longer responds to the buttons on the screen.

Performing a soft reset
A soft reset allows your RDA to get a fresh start, similar to rebooting a desktop
computer. All records and entries are retained after a soft reset.

To perform a soft reset, press and release the Power and Backlight button together.

Performing a hard reset
A hard reset will erase all records and entries stored in your RDA. Never perform a hard
reset unless a soft reset does not correct your problem. Always ensure you have
performed a HotSync operation, if possible, before performing a hard reset on your
RDA. When you perform your next HotSync operation, you can restore any data that
you previously synchronized to your desktop computer.

To perform a hard reset, do the following:
1. Press and hold the Power and Backlight buttons together, then release the

Backlight button only.
2. Release the Power button when the Palm Powered logo appears.
3. Follow on-screen instructions:

· If you want to abandon the hard reset, press the down arrow button.
· If you want to continue with the hard reset, press the up arrow button.

NOTE
When you perform a hard reset, the current date and time are retained. Formats, preferences, and
other settings are restored to their factory default settings.

Meazura™ MEZ1000 components

Front panel components

Power Button

Directional

Arrow Buttons

Center Button

Backlight Button

MZIO™ Module

Graffiti

Pad

Touch

Sensitive
Screen

Front View

· Power Button
Pressing the power button turns the RDA on (if it is off) and returns to the last screen
that was displayed. Press the power button again to turn the RDA off.

· Backlight Button
Use the backlight to illuminate the screen in low-light conditions. Press the backlight
button to turn the backlight on (if it is off). Press the backlight button again to turn
the backlight off.
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The backlight button is also used to launch the screen contrast control. Press and
hold the backlight button for about 1.5 seconds until the contrast slider appears on
the RDA screen. Use the stylus to drag the contrast slider to the desired contrast and
then tap Done. To fine tune the contrast, you can use the up and down directional
arrow buttons.

· Center Button
The center button is a user configurable button. It can be used as a quick start
button for any application loaded onto your RDA. To configure the center button, tap
on the 'Prefs' application from the main screen. From the pick list on the upper right
of the screen, choose 'Buttons'. Next to the center button icon of this screen is
another pick list, displaying your presently installed applications. Simply choose your
application from this list to assign it to the center button.

The center button is assigned by default to switch application categories.

· Directional Arrow Buttons
The four directional arrow buttons can be used for vertical and horizontal scrolling on
palm software applications that allow scrolling. For more information on how to scroll,
refer to the specific documentation on each palm software application.

NOTE
Horizontal scrolling is not used in the standard palm applications that ship with your Meazura™
MEZ1000 RDA. Standard palm applications included with your Meazura™ MEZ1000 RDA are;
Address Book, Date Book, Expense, Memo Pad and To Do List.

· Touch Sensitive Screen
Displays the applications and data stored in your RDA. It is touch-sensitive and
responds to stylus contact. To protect your screen against scratching, we recommend
using screen protectors.

· Graffiti Pad
Write letters and numbers in this area using the Graffiti® 2 alphabet. For information
on how to enter data using the Graffiti® 2 characters see
"Entering Data using Graffiti®2 handwriting software" in chapter 2.

Home Icon
Tapping on the Home icon will return you to the Applications Launcher screen, viewing
the last category you had open. Tapping this icon repeatedly will switch application
categories also available from the pick list in the Application Launcher.

Options Icon
Tapping on the Options icon will open the Menu Bar, located at the top of your screen.
From this Menu Bar you can manage your applications and data by setting various
options and preferences as well as performing standard copy/paste actions. For more
information on managing your applications, see "Managing Applications" in chapter 3.

Calculator Icon
Tapping on this Icon will open the calculator application. For more information on using
your calculator, see "Using the calculator" located in chapter 4,
"Working With Applications".

Find Icon
Tapping on the Find icon will open the Find application, that lets you locate text in all
applications. For more information on using the Find option see "Using the find option"
located in chapter 8, "Performing Common Tasks".
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· MZIO™ Module
The MZIO™ module allows you to expand the functionality of RDA. Module options
are available from Aceeca and other OEM manufacturers. For more details on these
options, refer to the Aceeca website: http://www.aceeca.com

Back panel components

Stylus

Communications and
Charging Connector

Battery Pack

Battery Clip

Back View

Bottom View

· Battery Pack
Your RDA features a long-life, rechargeable, lithium-ion battery pack. The battery pack will provide
45 days standby, 60 hours continual usage.

· Battery Clip
The battery clip attached to your RDA is designed to protect against unintentional battery removal.
To remove the battery clip simply insert two small flat head screwdrivers, one above the clip to
push it down, the other under the side of the clip to lever it up and away from your RDA.

· Communications and Charging Connector
Connects your RDA to the cradle or communications cable, which in turn connects to the back of
your desktop computer and to the wall current through the AC adapter.

This allows you to recharge your Meazura™ MEZ1000 RDA as well as update the information
between your RDA and your desktop computer using HotSync technology.

The cradle or communications cable must be plugged into the serial or USB (COM) port at the back
of your desktop computer.

Serial Connection USB Connection

Your RDA requires a dedicated port. It cannot share a port with an internal modem or other device.
If you are unsure about the exact location of the serial or USB port on your desktop computer,

http://www.aceeca.com
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refer to the user's manual supplied with the desktop computer.

An additional connection is made from the back of the cradle or cable's serial or USB (COM) port
connector to the AC adapter which plugs into any AC outlet.

· Stylus
Your RDA comes with two styli (one replacement). Using only the stylus on your touch-sensitive
screen will protect your screen against scratching.

Other components

Infrared Port

Module Fasteners

Top View

· Infrared Port
Uses infrared technology to transmit and receive data to and from other Meazura™ MEZ1000
RDA's, and to perform HotSync operations. See "Beaming Information" in chapter 10, and "IR
HotSync operations" in chapter 11 for more information.

· Module Fasteners

Connecting the cradle

The cable or cradle that comes with your Meazura™ MEZ1000 RDA enables you to synchronize the
information on your Meazura™ MEZ1000 RDA with the Palm Desktop using HotSync® technology.

To connect your cable or cradle on a PC-compatible computer:
Turn off your computer and plug the USB or serial plug from the Meazura™ MEZ1000 RDA cable or
cradle into the serial (COM) port or USB port on your desktop computer.

Serial Connection USB Connection

NOTE
Your Meazura™ MEZ1000 RDA requires a dedicated port. It cannot share a port with an internal
modem or other device. If you are unsure about the exact location of the serial port on your
desktop computer, refer to the manual supplied with the desktop computer.
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Tapping versus clicking

Just as you use a mouse pointer to click elements on your desktop computer's screen, you use the
stylus to tap elements on your RDA's touch-sensitive screen. Tapping is the basic action used to
execute tasks on your RDA.

Always use the point of the stylus for tapping or making strokes on the RDA screen. Do not use a
pen, pencil, or any other sharp object to write on the RDA screen.

With your RDA turned on, you can tap the RDA screen to perform many operations, such as the
following:
· Open applications.
· Choose menu commands.
· Initiate a global Find operation.
· Select options in dialog boxes.
· Open the onscreen keyboards.

Just as you drag the mouse to select text or move objects on your computer, you can drag the stylus
to select text. In addition, you can use the stylus to drag the slider of any scroll bar.

Adjusting the contrast of your screen

You can adjust the contrast of your screen to make it easy to see in a variety of lighting conditions.

To adjust the contrast of your RDA screen:
1. Turn on your device.

2. Press and hold the backlight button for approximately 1.5 seconds. The Adjust Contrast slider
appears.

3. Do one of the following:
· Drag the slider to adjust the contrast.
· Tap to the right or left of the slider to adjust the contrast in small increments.
· Press or press and hold the UP or DOWN arrow buttons to adjust the contrast in small or large

increments, respectively.

Opening applications

You can use the Applications Launcher menu to open any application installed on your RDA.

In addition to providing a way for you to open applications, the Applications Launcher menu displays
the current time, battery level, and application category.

To open an application:
1. Tap the Home icon located on the Graffiti Pad to access the Applications Launcher menu.
2. Tap the icon of the application you want to open. If you have many applications installed in your



17

Meazura™ MEZ1000 RDA, tap the scroll bar to see all the available applications.

TIP
You can find an application quickly by writing the Graffiti 2 character for the first letter of its name.
The Application Launcher scrolls to the first application with a name that begins with that letter.



Using the RDA interface (Introduction to the Meazura™ MEZ1000 RDA)

Using the RDA interface

Your RDA includes the following interface elements:

Menu Bar
The menu bar contains a set of menu commands specific to the application.
The Menu Bar appears at the top of the screen on your RDA when the
Options icon is tapped. Not all applications have a menu bar.

Command Bar
The command bar lets you tap icons or write a ShortCut stroke to initiate a
command instead of tapping a command in the menu bar. The icons
displayed in the command bar vary within each application.

Icons
Icons open applications and menus, and find text anywhere in your data.
Icons are displayed on-screen and on the Graffiti Pad. Graffiti Pad icons are
explained in more detail in "Front panel components" earlier in this chapter.

ABC Dot
The ABC Dot in the input area activates the alphabetic keyboard when
tapped; note that the cursor must be in an input field for this option to work.

123 Dot
The 123 dot in the input area displays the numeric keyboard when tapped;
note that the cursor must be in an input field for this option to work.

 Check Boxes
Check boxes indicate the state of the corresponding option. A check mark in
a check box means the option is active. If a check box is empty, tapping it
inserts a check mark. If a check box is checked, tapping it removes the
check mark.

Pick Lists
Pick lists display a list of choices. Tap the black triangle next to the pick list
name to display a list of choices, and then tap an item in the list to select it.

Scroll Bars & Scroll Buttons
The scroll bar moves through long notes or memos. Tap and hold down the
scroll bar slider to scroll through pages; tap the slider arrow at either end to
move one line at a time. To scroll to the previous page, tap the scroll bar
just above the slider; to scroll to the next page, tap the scroll bar just below
the slider. You can also scroll to the previous and next pages by pressing the
upper and lower portions of the scroll button on the front panel of the RDA.
The scroll bars can control srolling one line at a time.

  Next/Previous Arrows
Next/previous arrows display the previous and next page of information.

Text and Number Input Areas
The text and numeric input areas of the Graffiti Pad allows you to enter
information as if you were writing with a pen and to access the on-screen
keyboards. Graffiti Pad writing is explained in more detail in
Entering data using Graffiti®2 handwriting software in chapter 2.
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Using menus and menu commands

Menus on your RDA are easy to use, and work the same way in all applications. Menu bars and
manual commands differ based on the application and the area of the application in which you're
working. For example, in the Memo Pad, the Memo List screen and the Memo screen display different
menus. Menu commands for each application are described in the corresponding application's chapter,
with the exception of the Edit menu. For information on Edit menu commands, see
"Using the Edit menu" in chapter 8.

Most menu commands have an equivalent Graffiti 2 command stroke, which is similar to keyboard
shortcuts used to execute commands on computers. To use Graffiti 2 menu commands, menus must
be closed.

To display a menu bar and choose a command, do one of the following:
· Open an application (such as the Date Book); then tap the Options icon. Select the desired

command from the menu.
· Tap the inverted tab at the top of the application's screen (the Calculator does not have an

inverted tab); then tap the desired command.
· In the text input area on your RDA, drag a diagonal line from the lower left to the upper right to

display the Command toolbar. The command bar is displayed for approximately 4 seconds.

Tap an icon that represents the command you want, or enter the shortcut for the command in the
text input area below the Command toolbar. For example, to choose Select All in the Edit menu, draw
the Graffiti 2 command stroke in the text area to display the Command toolbar; then draw the letter
S. Note that if you wait more than three seconds to draw the shortcut letter, you'll have to redraw the
Graffiti 2 command stroke to redisplay the Command toolbar.

Displaying tips

Many of the dialog boxes that appear on your RDA contain a Tips icon in the upper right corner. Tips
anticipate questions you may have and provide shortcuts for using the dialog box or other useful
information.

To display a tip:
1. Tap the Tips icon (the lowercase 'i' in the upper right corner of a dialog box).

Tips icon

2. Tap Done after reading the tip.

Entering data

You can enter data into your Meazura™ MEZ1000 in three ways:
· Using the onscreen keyboard
· Using Graffiti 2
· Entering or importing data in Palm Desktop, and then synchronizing with your RDA
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For more information, see these topics in chapter 2,
"Entering Data in Your Meazura™ MEZ1000 RDA".

Customizing your RDA

You can customize your RDA to do the following:
· Display personal information such as your name and address
· Display the current date and time, and different date and time formats for other countries and time

zones
· Shut down after a specific time, to save the battery
· Stay on while charging when connected to the cable or cradle
· Control the sound volume
· Automatically receive any data beamed to it

Selecting the preferences screen

You set preferences to customize your device. To select the Preferences screen do the following:
1. Tap the Home icon to access the Aplications Launcher menu.
2. Tap the Prefs icon.

Personalizing your RDA

Use Owner Preferences to record a name, company name, phone number, or any other information
you want to display on your RDA.

If you use the Security application to turn off and lock your RDA with a password, information that
you enter in the Owner Preferences appears the next time you turn on your RDA.

To change owner preferences on your RDA:
1. From the Preferences screen, tap Owner from the pick list in the uper right corner.
2. On the Owner Preferences screen, enter the text you want to associate with your RDA. If you

enter more text than can fit on one screen, a scroll bar appears at the right side of the screen.

NOTE
If you assigned a password to your device using the Security application, you must unlock the
Owner Preferences screen to change the information in it.

To unlock the Owner Preferences screen:
1. Display the Owner Preferences screen.
2. Tap Unlock. The Unlock Message dialog box appears.
3. Enter your current password (the one you entered in the Security application); then tap OK.
4. Edit the Owner Preferences text as desired.
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Setting the date, time and time zone

The Date & Time screen lets you set the date, time, time zone, and daylight savings time for your
device.

Setting the date:
1. Tap the Home icon to access the Applications Launcher menu, then tap the Prefs icon.
2. From the pick list in the upper right corner, tap Date & Time.
3. On the Date & Time screen, tap the Set Date box; then tap the arrows at the top of the Set Date

Screen to select the current year.
4. Tap the month; then tap the current date.

The screen closes and the date you selected is displayed.

Setting the time:
1. Tap the Home icon to access the Applications Launcher menu; then tap the Prefs icon.
2. From the pick list in the upper right corner, tap Date & Time.
3. On the Date & Time screen, tap the Set Time box then tap the Up or Down arrow to change the

hour.
4. Tap each minute number, and then tap an arrow to change the number.
5. If available, tap AM or PM.
6. Tap OK to set the new time and return to the Date & Time screen.

NOTE
To display time based on a 24-hour clock, change the time format. See
"Formatting the date, time, and numbers" later in this chapter.

Setting the time zone:
1. Tap the Home icon to access the Applications Launcher menu; then tap the Prefs icon.
2. From the pick list in the upper right corner, tap Date & Time.
3. On the preferences screen, tap the Set Time Zone box.

4. Use the up and down arrows to scroll to your country and time zone. The hardware scroll buttons
can be used to scroll the list a page at a time.

5. Make sure your time zone is highlighted, then tap OK.
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TIP
Choose the time zone from the list that corresponds to where you are. When you travel, use this
dialog to change time zones. If you're not sure what time zone you are in, find out what time it is,
and select the time zone which shows the current new time. Do not use the time zone dialog to
switch between daylight savings time and standard time. Use the Daylight Savings pick list.

The screen closes and the time you selected is displayed.

Setting daylight savings time:
1. Tap the Home icon to access the Applications Launcher menu, then select Date & Time from the

pick list in the uper right corner of the screen.
2. Tap on the Daylight Saving pick list to toggle this feature on or off.

Formatting the date, time and numbers

The Formats Preferences screen lets you choose a default country for your device and also lets you
set defaults for times, dates, and number formats. When selecting a country and time, date, and
number formats, keep the following in mind:
· When you select a country, the time, date, and number formats are adjusted, as well as the week's

starting day. For example, in Germany, time often is expressed using a 24-hour clock and the
starting day of the week is Monday; in the United States, however, time is expressed using a 12-
hour clock with an AM or PM suffix and the starting day of the week is Sunday. You can customize
your own settings.

· The Time setting defines the format for the time of day, which appears in all applications on your
RDA.

To choose a country default:
1. Tap the Home icon to access the Application Launcher menu; then tap the Prefs icons.
2. In the pick list in the upper right corner, tap Formats.
3. Tap the Preset To pick list, and tap a country name.

To change the formatting of the time, date, week start, and numbers:

NOTE
This setting controls the Day, Week, Month, and Agenda views in Date Book and all ther aspects of
your RDA that display a calendar.

1. Tap the Home icon to access the Application Launcher menu; then tap the Prefs icon.
2. In the pick list in the upper right corner, tap Formats.
3. In the Formats Preferences screen, tap the Time pick list and select a format, where H is hour

and M is minute.
4. Tap the Date pick list and select a format, where D is day, M is month, and Y is year.
5. Tap the Week starts pick list, and select whether you want the first day of the week to be

Sunday or Monday.
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6. Tap the Numbers pick list, and select formats for the decimal point and thousands separator.

Setting the auto-off delay time

You can set when your RDA automatically shuts off. Using the auto shutoff interval, your RDA
automatically turns off the power and backlight after a period of inactivity, to conserve battery power.
If you find that your RDA shuts itself off before you finish reviewing the information on the screen,
you can increase the automatic shutoff setting.

To set the auto shutoff interval:
1. Tap the Home icon to access the Application Launcher menu; then tap the Prefs icon.
2. In the pick list in the upper right corner, tap General.
3. In the General Preferences screen, change the auto-shutoff time by tapping the Auto-off After

pick list. Tap an option—30 seconds, 1 minute, 2 minutes, or 3 minutes.

Setting your RDA to stay on while charging

In order to save battery power, your RDA will shut off after the time interval that is set in your
General Preferences. You may choose to have the screen remain visible while charging.

To set your device to stay on while charging:
1. Tap the Home icon to access the Application Launcher menu; then tap the Prefs icon.
2. In the pick list in the upper right corner, tap General.
3. Tap the "Stay on while charging" check box to allow your RDA to stay on while charging.

Unchecking the box causes your RDA to shut off after the auto shutoff time interval that is set in
your General Preferences.

Setting the sounds and volumes

You can control the sound for system alerts, alarms, and games using the General Preferences
screen.

To set the auto shutoff interval and sounds:
1. Tap the Home icon to access the Application Launcher menu; then tap the Prefs icon.
2. In the pick list in the upper right corner, tap General.
3. To set sounds and volumes, tap the System, Alarm, or Game Sound pick list, and select the

sound level—Off, Low, Medium, or High.

NOTE
Turning off the System Sound also turns off the chime tones used during HotSync operations. The
Game Sound setting typically works only with newer games that are programmed to respond to it.
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Turning Beam Receive on and off

Beaming is discussed in chapter 9. For information on using the Beam Receive preference, see
"Turning off beaming" in that chapter.

For information on assigning different applications to your RDA's buttons see chapter 3,
"Managing Applications".

For information on configuring your RDA to work with a modem or network, see chapter 11, "Setting
Connection and Network Preferences".

Palm Desktop Software

Palm Desktop software includes the same main applications as your Meazura™ MEZ1000 RDA:
Address Book, Date Book, To Do List and Memo Pad. You can use the HotSync feature of this software
to back up and exchange data between your RDA and your desktop computer.

It's a good idea to back up your data in case something happens to the data on your Meazura™
MEZ1000 RDA. Changes you make on your Meazura™ MEZ1000 RDA or Palm Desktop appear in both
places after you synchronize.

Using the Palm Desktop, you can do the following:
· Work with your Meazura™ MEZ1000 RDA applications on your desktop computer. Palm Desktop

duplicates the Date Book, Address Book, To Do List, and Memo Pad applications on your RDA, so
that you can view, enter, and modify any data stored on your RDA.

· Back up the data stored on your RDA with HotSync technology and synchronize the data on your
Palm Desktop. Synchronization is a one-step procedure that ensures your data is always safe and
up-to-date. See "Exchanging and Updating Data using HotSync Operations" in chapter 10 for more
information.

· Import and export data, so you can easily transfer data from other desktop applications into any of
your main applications. See "Importing data" in chapter 2 for more information.

· Print your Date Book, Address Book, To Do List, and Memo Pad information on any printer.

Installing Palm Desktop Software

The following instructions guide you through installing Palm Desktop so that you can transfer data
from your computer to your RDA.

After installation, refer to the online Help in Palm Desktop for information on how to use the software.

To ensure a safe and uninterrupted installation of Palm Desktop, do the following before
installing:
· Turn off your computer and connect the cradle/communications cable to it. Do not place your RDA

in the cradle or connect it to the communications cable until instructed.
· Do not copy the Palm Desktop files to your computer's hard disk. You must use the installer to

place the files in their proper locations and to decompress the files.
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Installing Palm Desktop Software on a Windows computer

1. Exit any open programs, including those that run at startup (such as Microsoft Office), and
disable any virus-scanning software.

2. Insert the Meazura™ Desktop CD into the desktop computer's CD-ROM drive.

NOTE
If the installation does not begin, click the Windows Start button, choose Run, enter
D:\install_menu.exe, and then click OK. If necessary, replace D: with the drive letter assigned to
your CD-ROM drive.

3. Follow the onscreen instructions to complete the installation. During installation, you may be
asked to insert your RDA into the cradle or connect it to the communications cable.

Using your RDA with another personal information
manager
If you prefer to use another personal information manager (PIM), such as Microsoft Outlook, you can
use it instead of installing Palm Desktop. All you need to install is HotSync Manager and the
connection software for your PIM, called a conduit, that lets you synchronize the data between your
RDA and your PIM. For information on conduit software, go to this web site:
http://www.palmsource.com.

http://www.palmsource.com
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Part II
Entering Data in Your Meazura™

MEZ1000 RDA

Using the onscreen keyboard

You can open the onscreen keyboard anytime you need to enter text or numbers on your RDA.

To use the onscreen keyboard:
1. Open any application (such as the Address Book).
2. Tap any record, or tap New.
3. Choose one of the following to display the alphabetic or numeric keyboard:

• Tap the ABC dot on the front of your RDA to display the alphabetic keyboard.
• Tap the 123 dot on the front of your RDA to display the numeric keyboard.
· Tap the Options icon; then tap Keyboard to display the alphabetic keyboard first by default

Tap abc for

alphabet

keyboard.

Tap 123 for

numeric

keyboard.

4. To display the international keyboard, tap either the ABC dot or the 123 dot on the front of your
RDA, and then tap Int'l at the bottom of the keyboard display.
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Numeric International

Alpha

Tap here to display

alphabetic keyboard

Carriage return

Backspace
Tab

Caps Lock

Caps Shift

Tap here to display

international keyboard

Tap here to display

numeric keyboard

5. Tap the desired characters or numbers; then tap Done to enter the text or numbers.

Entering data using Graffiti®2 handwriting software

You can use Graffiti 2 strokes to create letters, numbers, punctuation, and symbols. The Graffiti 2
writing strokes include all letters, numbers, and symbols found on a standard keyboard.

Learning to write Graffiti®2 characters

With only a few minutes of practice, you'll find it easy to enter accurate text and numbers using
Graffiti 2 writing strokes.

The Graffiti 2 demo shows how to use the handwriting software. The first time you turn on your RDA,
or perform a hard reset, the Welcome application will automatically guide you through the setup
process. When you complete setup, you will be invited to learn how to use your handwriting software.
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You should try the demo if Graffiti 2 is new to you. After you view the Welcome
application the first time, a Graffiti 2 Demo icon will appear on the Applications Launcher
menu. Tap on this icon to view the demo at any time.

TIP
When you reach the Stroke Lookup screen of the demo, use the pick list to view the wide variety of
characters that you can make. As you tap a character, you will see an animation of the strokes
used to form that character.

General guidelines for Graffiti®2 Writing

Follow these guidelines to learn and use Graffiti 2 writing strokes successfully:
· To achieve 100% accuracy, practice drawing characters exactly as they appear in the tables later in

this chapter.

· The heavy dot on each shape indicates where to start the stroke. Some characters have similar
shapes, but different starting and ending points. Always start the stroke at the heavy dot. (Do not
draw the heavy dot; it is there only as a guideline.)

· The Graffiti 2 writing strokes for letters closely resemble letters of the standard English alphabet,
both upper case and lower case. Graffiti 2 includes symbols made with a single stroke and symbols
made with multiple strokes.

For multi-stroke characters, a temporary character is displayed after the first stroke, to show that
the stroke was recognized. For example, after the first vertical stroke of "t", a temporary "l" is
shown. There is a limited time window, during which the second stroke must be drawn. Otherwise
the temporary stroke is recorded.

· The text input area is divided into two parts, one for writing lowercase letters and one for writing
numbers. The small marks at the top and bottom of the text input area define the division line. To
have your RDA recognize letters and numbers, you must begin letter strokes on the left side, and
number strokes on the right side of the text input area. Uppercase letters are formed by writing
across the division line.
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Write numbers here
Write lowercase

letters here

Write uppercase letters

across these division marks

To write Graffiti 2 letters:
1. Tap the screen where you want to write text, for example, on a line next to a time in the Date

Book.

NOTE
A blinking cursor must appear onscreen above the Graffiti 2 writing area before you can begin
writing text.

Blinking cursor

2. Use the tables on the following pages to find the stroke shape for the letter you want to write.
For example, the stroke shown below creates the letter n.

Lift stylus here

Start stroke

at heavy dot

You use the same shape to create the lowercase letter and the uppercase letter.

3. Position the stylus in the appropriate place of the text input area.
4. Start your stroke at the heavy dot, and draw the stroke shape as it appears in the tables.
5. Lift the stylus from the screen at the end of the stroke shape.
6. Your RDA recognizes your stroke immediately and displays the letter at the insertion point

onscreen. As soon as you lift the stylus from the screen, you can begin the stroke for the next
character you want to write.

Graffiti®2 tips

When using Graffiti 2 writing, keep the following tips in mind:
· For greater accuracy, draw letters with large strokes; strokes that nearly fill the text input area are

easily interpreted.
· To delete characters, set the insertion point to the right of the character you want to delete, and

draw the Backspace stroke (a line from right to left) in the text input area.
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· Write at natural speed. Writing too slowly can produce errors.
· Do not write at a slant. Keep vertical strokes parallel to the sides of the text input area.
· When letters and numbers can be written using two different strokes, use the one that's easiest for

you.
· Press firmly.

The Graffiti®2 alphabet

Draw Graffiti 2 letters according to the following alphabet.

Write numbers here
Write lowercase
letters here

Write uppercase letters

across these division marks

Writing punctuation marks and other special characters

Using Graffiti 2 writing, you can create any punctuation symbol and special character available from a
standard keyboard.
· The period and comma punctuation marks can be written on either side of the text input area (the

letter or number side). Other common punctuation marks can be written on one side of the text
input area according to the chart below (in general, the more frequently used punctuation is on the
left side).

Note that the punctuation characters can also be entered anywhere on the text input area if you
first use the shift character. This requires an additional shift stroke, but you may find it more
convenient, since you don't have to remember on which side of the input area to make the stroke.

· When writing letters with accent marks, first write the letter stroke on the left side (or in the center
for uppercase letters) of the input area. Then quickly write the accent stroke on the right side of
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the input area, as shown in the illustration below.
· Symbols and other special characters can be written using the Shift command. When you make a

vertical stroke from the bottom to the top in the text input area, the Shift indicator arrow appears
in the lower right corner of the screen. While this arrow is visible , you can make the punctuation
shift characters shown in the illustration below. Once the arrow goes away, the punctuation mark
appears.

TIP
Using an additional Shift stroke to finish writing the character (as shown in the demo) is optional,
but will make the character appear more quickly.

Draw punctuation, symbols or accent marks using the following strokes:

TIP
Samples of the character strokes are available in the Graffiti 2 Help file. To view the Help file, use
the full-screen pen stroke, dragging the stylus from the text input area to the top of the screen.
Note that the accented characters appear on a Punctuation Shift screen, but do not use the Shift
command. To write uppercase accented characters, write the letter across the division mark, just
as you would do with an ordinary letter.

Using the Graffiti®2 tuner

The Graffiti 2 tuner provides alternate strokes for making the T, P, Y, and $ characters. For example,
you may want to form the letter "T" by using strokes similar to a space and an "L". But if this
technique is difficult to control, you can turn off this option.

To use the tuner:
1. Tap the Home icon to access the Application Launcher menu.
2. Tap on the Prefs icon.
3. Select Graffiti 2 from the pick list in the upper right corner of the screen.
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4. Tap on one of the letters available for you to tune.

Using Graffiti®2 Gestures

Gestures are editing commands, such as cut, paste, and the ShortCut command which will be
explained in the next section. To use gestures, draw the following strokes:

Using Graffiti®2 ShortCuts

Graffiti 2 ShortCuts let you quickly and easily enter commonly used words or phrases. ShortCuts are
similar to the Glossary or Autotext features of some word processors. Graffiti 2 writing comes with
several predefined ShortCuts. You can also create your own, for any words, letters, or numbers.

You can create ShortCuts, with up to 45 characters, using the ShortCut preferences. For example, you
could create a ShortCut for your name or for the header of a memo. All ShortCuts you create appear
on the list in the ShortCut Preferences screen, are available in any of your RDA applications, and are
backed up on your desktop computer when you perform a HotSync® operation.

Your RDA includes the following predefined Graffiti 2 ShortCuts for common entries:
· ds — Date stamp
· ts — Time stamp
· dts — Date/time stamp
· me — Meeting
· br — Breakfast
· lu — Lunch
· di — Dinner

To use a Shortcut:
Draw the ShortCut stroke, followed by the ShortCut character or characters.
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When you draw the ShortCut stroke, the ShortCut symbol appears at the insertion point.

To create a Shortcut:
1. Tap the Home icon to access the Application Launcher menu.
2. Tap the Prefs icon.
3. Tap Shortcuts in the pick list in the upper right corner.
4. Tap New.
5. In the ShortCut Name line of the ShortCut Entry screen, enter the letters you want to use to

activate the ShortCut.

Tap New.

6. Tap the ShortCut Text area, then enter the text that will appear when you write the ShortCut
characters.

7. You can add a space character after the last word in your ShortCut text, so that a space
automatically follows the ShortCut text.

8. Tap OK.

To edit a ShortCut:
1. In the ShortCut Preferences screen, tap the ShortCut you want to edit.
2. Tap Edit.
3. Make the changes you want; then tap OK.

To delete a ShortCut:
1. In the ShortCut Preferences screen, tap the ShortCut you want to delete.
2. Tap Delete; then tap Yes.

Using your computer keyboard

At times, you may prefer to use your desktop computer keyboard rather than the onscreen keyboard
to enter information or add new records to your RDA.

You can enter information from your desktop computer keyboard, using Palm Desktop or any
supported personal information manager (PIM) installed for use with your RDA. You can then perform
a HotSync operation to synchronize the information on your desktop computer with the information
you entered on your RDA. All the main applications on your RDA are available in Palm Desktop and in
most PIMs.

Refer to Palm Desktop Help for more information on entering data on your desktop computer.
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Importing data

If you have data stored in computer applications such as spreadsheets and databases, or if you want
to import data from another device, you can transfer the data to your Meazura™ MEZ1000 RDA
without having to key it in manually. Save the data in one of the file formats listed below, import it
into Palm Desktop, and then perform a HotSync operation to transfer the data to your RDA.

Palm Desktop can import data in the following file formats:
· Comma delimited (.csv, .txt): Address Book and Memo Pad only.
· Tab delimited (.tab, .tsv, .txt): Address Book and Memo Pad only.
· CSV (Lotus Organizer 2.x/97 Mapping): Address Book only.
· Date Book archive (.dba).
· Address Book archive (.aba).
· To Do List archive (.tda).
· Memo Pad archive (.mpa).

Archive formats can only be used with Palm Desktop. Use the archive file formats to share
information with other people who use Palm Powered handhelds or to create a copy of your important
Palm Desktop information.

To import data:
1. Open Palm Desktop.
2. Click the application into which you want to import data.
3. If you are importing records that contain a field with category names, do the following:

a. Select All in the Category box.
b. Make sure that the same categories that appear in the imported file also exist in

the application. If the categories do not exist, create them now; otherwise, the
records will be imported into the Unfiled category.

4. Choose File > Import; then select the file you want to import, and click Import.
5. To import data into the correct Palm Desktop fields, drag fields in the left column so that they

are opposite the corresponding imported field on the right.
6. To exclude a field from being imported, deselect the field's check box.
7. Click OK.
8. The imported data is highlighted in the application.
9. To add the imported data to your RDA, perform a HotSync operation.

See Palm Desktop online Help for more information on importing and exporting data.
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Part III
Managing Applications

Using the Applications Launcher menu

The Applications Launcher menu displays all the available applications on your RDA by default. You
can also display only selected applications by arranging applications into categories.

To open the Applications Launcher:
Tap the Home icon to access the Applications Launcher menu.

Applications

Launcher

Selecting applications

Your Meazura™ MEZ1000 RDA is equipped with a variety of applications. All the applications installed
on your RDA appear in the Applications Launcher menu.

In addition to providing a way for you to open applications, the Applications Launcher menu displays
the current time, battery level, and application category.

Opening an application

Choose from the following options:
· Tap the Home icon to access the Application Launcher menu, and then tap the icon of the

application you want to open. If you have many applications installed on your Meazura™ MEZ1000
RDA, tap the scroll bar to see all the available applications.

· Press an application button on the front panel to display the selected application immediately.
· To switch between applications, tap the Home icon or press an application button on the front panel

of your RDA. Your RDA automatically saves your work in the current application and displays it
when you return to that application.

Categorizing applications

The category feature enables you to manage the number of application icons that appear onscreen in
the Applications Launcher menu. You can assign an application to a category and then display a single
category or all your applications.

To categorize an application:
1. Tap the Home icon  to access the Application Launcher menu.
2. Tap the Options icon.
3. From the App menu, tap Category.
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4. Choose from the following options:
· To choose a category for an application, tap the pick list next to each application.
· To create a new category for an application, tap Edit Categories from the application's pick

list. Tap New, enter the category name, and then tap OK to add the category. Tap OK.
5. Tap Done.

Displaying applications by category

1. Tap the Home icon to access the Application Launcher menu.
2. Do one of the following:

· Tap the Home icon or Center button on the front of your RDA repeatedly to cycle through all
the categories.

· Tap the pick list in the upper right corner of the screen; then tap the category you want to
display.

Changing the Applications Launcher display

By default, the Applications Launcher menu displays applications as icons. As an alternative, you can
display applications in a list format.

Changing the view of applications

1. Tap the Home icon to access the Application Launcher menu; then tap the Options icon.
2. From the Options menu, tap Preferences.
3. From the View By option tap List; then tap OK to see your applications in list format.

In addition to displaying applications by icon or list, you can set an option to display the last-selected
category of applications each time you open the Applications Launcher menu.

Displaying the last selected category of applications

1. Tap the Home icon to access the Application Launcher menu; then tap the Options icon.
2. From the Options menu, tap Preferences.
3. In the Preferences dialog box, tap Remember Last Category.
4. Tap OK.

Each time you return to the Applications Launcher menu, the last category of applications you
selected is displayed.

NOTE
If you do not select the Remember Last Category option, all applications are displayed when you
access the Applications Launcher.
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Setting preferences for applications

You can set preferences for individual applications in the Preferences dialog box. Not all applications
have preference settings.

To set preferences for an application:
1. Open an application. For instructions, see "Selecting applications" in this chapter.
2. Tap the Options icon.
3. From the Options menu, select Preferences.
4. Enter the desired preference settings; then tap OK.

Assigning applications to buttons

Buttons preferences let you assign different applications to the center button on the front of the RDA
the Calculator icon and to the HotSync button on the cradle.

You can also change whether the full-screen pen stroke activates the Graffiti® 2 Help application or
one of your RDA controls using Buttons preferences.

Drag stylus from input
text area to top of screen

If you assign a different application to the center button, you can still select the original application
using the Applications Launcher. Changes made in the Buttons Preferences screen or HotSync Buttons
dialog box take effect immediately.

Changing the Buttons preferences

1. Tap the Home icon to access the Application Launcher menu.
2. Select All or System from the pick list in the upper right corner.
3. Select Prefs from the menu.
4. In the pick list in the upper right corner, tap Buttons.
5. In the Buttons Preferences screen, tap the pick list next to the button you want to re-assign.
6. Tap the application that you want to assign to the button.

TIP
To restore all of the buttons to their factory settings, tap Default.
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Changing the HotSync buttons preferences

1. Tap the Home icon to access the Application Launcher menu; then tap the Prefs icon.
2. In the pick list in the upper right corner, tap Buttons.
3. In the Buttons Preferences screen, tap HotSync.
4. Tap the pick list next to the HotSync button you want to assign.

Tap arrow to
show pick list

5. Tap the application you want to assign to each HotSync button.

The default setting for each button is the HotSync setting, which means the cradle performs it's
normal HotSync operations.

6. Tap OK.

Changing what the full-screen pen stroke activates

1. Tap the Home icon to access the Application Launcher menu.
2. Select All or System from the pick list in the upper right corner.
3. Select Prefs from the menu.
4. In the pick list in the upper right corner, tap Buttons.
5. In the Buttons Preferences screen, tap Pen.

6. Tap the pick list, and tap one of the following settings for the fullscreen pen stroke:

· Backlight turns on the backlight of your RDA.
· Keyboard opens the onscreen keyboard for entering text characters.
· Graffiti 2 Help opens a series of screens that show the complete Graffiti 2 character set.
· Turn Off & Lock turns off and locks the RDA. You must assign a password to lock the RDA.

When locked, you need to enter the password to use your RDA.
· Beam Data beams the current record to another Palm Powered organizer.

7. Tap OK.
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Installing add-on applications

In addition to the applications that came with your RDA, you can install applications (called add-on
applications) using the Install Tool during a HotSync® operation. A variety of third-party applications
are available for your device, such as games and other software, from the following the web site:
http://www.palmsource.com.

Add-on applications reside in RAM memory and can be removed at any time; for information, see
"Removing applications" later in this chapter.

In addition, you can install games included on the CD using the Palm Install Tool. These games
include:
· Giraffe (a fun, simple way to practice Graffiti 2 writing)
· HardBall
· Puzzle

After you install and start a game, its instructions appear in the Game menu. Depending on the
game, the Game menu may also contain commands to show high scores, start a new game, or set
preferences for the game.

Installing add-on applications on your RDA in Windows

1. From your computer desktop, copy or download the applications you want to install into the add-
on folder in your Palm Desktop directory.

2. If the application is compressed, for example, as a .zip file, decompress the application into the
add-on folder before continuing.

3. Double-click the Palm Desktop icon on your computer desktop to open it; then click Install.

http://www.palmsource.com
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TIP
You can also select the Install Tool dialog box by selecting Install Tool from the Palm Desktop
program group or by double-clicking any file with a PRC file extension.

4. In the User drop-down list, select the user name that corresponds to your Meazura™ MEZ1000
RDA; then click Add.

5. In the file list of the Add-on folder, select the application that you want to install on your RDA;
then click Open. The file appears in the Palm Install Tool dialog box.

6. If you decide not to install an application, select it in the list of files in the Palm Install Tool
dialog box and click Remove. The application is removed from the dialog box list, but not from
your desktop computer.

7. Click Done. A message appears to indicate that the application or applications will be installed
the next time you perform a HotSync operation.

8. Perform a HotSync operation to install the applications. See Chapter 11,
"Exchanging and Updating Data using HotSync Operations" for more information.

Removing applications

You can remove add-on applications, patches, and extensions from your RDA if you run out of
memory or no longer need them.

You cannot remove the built-in applications that reside in the ROM portion of your device, including
Date Book, Address Book, To Do List, Memo Pad, Calculator, and Mail applications.

To remove an add-on application:
1. Tap the Home icon to access the Application Launcher menu; then tap the Options icon.
2. From the App menu, tap Delete.
3. In the Delete dialog box, tap the application you want to remove.
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4. Tap Delete.
5. Tap Yes.
6. Tap Done.

Removing Palm Desktop Software

If you no longer want to use Palm Desktop, you can remove it from your computer.

To remove Palm Desktop from Windows:
1. In Windows, from the Start menu, choose Settings > Control Panel.
2. Open the Add/Remove Programs icon.
3. On the Install/Uninstall tab, select Palm Desktop; then click Add/Remove.

NOTE
You must retain the HotSync Manager from the installation CD to synchronize data with another
PIM.

Assigning security options

Your RDA includes a Security application that lets you set options to protect entries from unauthorized
users in a variety of ways:

The Security application lets you:
· Mask or hide entries you have defined as private. The Mask option displays a gray bar over private

records, and the Hide option completely removes (hides) private records.
· Assign a password to viewing options to enhance security. Assigning a password requires you to

enter a password before private entries can be viewed; not assigning a password lets you view
private entries when you Show Records from the Security dialog box.

· Lock and turn off your RDA so that a password must be entered before you can use the device
again.

· Hide records that you have defined as private, with or without a password. Without a password,
private records are hidden until you set the Security application to display them; with a password,
you must enter the password to view the private entries.

Masking and hiding records

You can mask or hide private records. When you mask private records, a visual placeholder appears
where the record would normally be displayed; when you hide records, they are not visible anywhere
in the list.
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Masking private records

1. Make sure that the record or records you want to mask are defined as private. To make a record
private, select the record, tap Edit, tap Details, and then tap the Private option.

2. From the Applications Launcher menu, tap Security.
3. From the Current Privacy pick list, tap Mask Records.

4. Open one of the basic applications and view a record. Records marked as private are masked
with a gray bar.

Hiding private records

1. Make sure that the record or records you want to hide are defined as private. To make a record
private, select the record, tap Edit, tap Details, and then tap the Private option.

2. From the Applications Launcher menu, tap Security.
3. From the Current Privacy pick list, tap Hide Records.
4. When you return to the Address Book, records marked as private are not included in the display

of names.

Note that you can mask or hide records without assigning a password, or you can assign a password
if you want records to remain masked or hidden until a password is entered.

Assigning and editing passwords

You can assign a password to protect your private records and to lock your RDA.

Once you define a password, you can change or delete it at any time. You must enter the current
password before you can change or delete it.

If you've forgotten your password, you can delete it. See "Recovering from a forgotten password"
later in this chapter.

Assigning, changing, or deleting a password

1. Tap the Home icon to access the Application Launcher menu.
2. Tap the Security icon.
3. Tap the Password box.
4. Enter a password—either the one you want to assign or your current password if you want to

change or delete it—and tap OK.



45

5. Choose from the following options:
· To assign a password, enter the password again to verify it, and tap OK.
· To change your password, enter a new password and tap OK.
· To delete your password, enter your current password. Tap OK, and then tap Delete.

Locking your RDA

You can turn off and lock your RDA with a password to protect information. You must then enter the
password when you turn on your device to gain access to the information on it.

If you forget the password, you must perform a hard reset to resume using your RDA. Performing a
hard reset deletes all the records in your RDA; however, you can restore all synchronized data at the
next HotSync operation. See "Performing a hard reset" in chapter 1 for more information.

Locking your RDA with a password

1. Assign a password, as described in "Assigning and editing passwords" earlier in this chapter. A
password is required before using the Turn Off & Lock option.

2. Tap Turn Off & Lock Device. The System Lockout dialog box appears.
3. Tap Off & Lock. You device is turned off and is locked.

To turn on and unlock your RDA:
1. Turn on your RDA.
2. Enter your password at the prompt; then tap OK.

Recovering from a forgotten password

If the Off & Lock option is not active, and you forget your password, you can delete the forgotten
password from your RDA. Deleting a forgotten password also deletes all entries and files marked as
Private.

IMPORTANT
If you synchronize with your desktop computer before deleting a forgotten password, your RDA
restores private entries the next time you perform a HotSync operation, but does not restore the
forgotten password.

Deleting a forgotten password

1. Tap the Home icon to access the Application Launcher menu, tap the Security icon.
2. From the Security dialog box, tap Forgotten Password.
3. A message appears; tap Yes to delete the forgotten password.
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Part IV
Working with Applications

Your Meazura™ MEZ1000 includes the following applications:
· Date Book.
· Address Book.
· To Do List.
· Memo Pad.
· Calculator.



  (Working with Applications)

Using the Date Book

The Date Book lets you quickly and easily schedule appointments or any activity
associated with a date or date and time. When you open the Date Book, the current
date and a list of times for a standard business day are displayed.

Use the Date Book to:
· Schedule events: timed events, which have both times and dates; untimed events, for example,

birthdays or anniversaries; repeating events, such as a weekly meeting held on the same day at
the same time; continuous events, such as a vacation or three-day conference; and all day events,
which reflect the default hours of a day as set by the user.

· Display your schedule in different ways: by Day, Week, Month, or Agenda view.
· Set an alarm to sound minutes, hours, or days before a scheduled appointment.
· Attach notes to events to describe or clarify Date Book entries.
· Rearrange or delete events from your schedule.



49

Opening the Date Book

Tap the Home icon to access the Applications Launcher menu; then tap the Date Book icon to open
the Date Book to today's schedule. The date is displayed at the top right of the screen.

Scheduling events

An entry in the Date Book is called an event. When you schedule an event, its description appears on
the time line, and its duration is set to 1 hour by default. You can easily change the start time and
duration for any event. You can schedule the following types of events in the Date Book:
· Timed events, such as meetings, that have a specific date and a specific start and end time.
· Untimed events, such as birthdays, holidays, and anniversaries. These events occur on a particular

date but have no specific start or end times; they appear at the top of the list of times marked with
a diamond. You can schedule more than one untimed event on the same date.

· Repeating events, such as a weekly meeting that is held on the same day at the same time each
week.

· Continuous events, such as a vacation or three-day conference.
· All day events, which reflect the default length of the day as set by the user.

Scheduling timed events

You can schedule timed events for the current date or for future dates.

To schedule a timed event for the current date:
1. Tap the Home icon to access the Applications Launcher menu, then tap the Date Book icon to

open the Date Book to today's schedule. The current date and a list of times for a normal
business day are displayed in Day view.

2. With the current day selected, tap the line next to the time that corresponds to the start of the
event.

Time bar
shows default
duration.

Tap a line next to
desired time;

then enter text.

3. Enter a description of the event, up to 255 characters in length.
4. Set the events duration:

· If the event is 1-hour long, skip to the end of this procedure
· If the event is longer or shorter than an hour, tap directly on the time to open the Set Time

dialog box.

Tap the time to
display the Set

Time dialog

box.
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TIP
You can open the Set Time dialog box (to select a start time) by making sure no event is selected,
and then writing a number on the number side of the text input area.

5. Set the duration of the event in either of the following ways:
· Tap the time columns in the Set Time dialog box to set the Start Time; Tap End Time; then

tap the time columns to set the End Time.
· Tap All Day if the event lasts all day. The default hours of a standard business day are set by

the user, and may be changed using the Preferences command in the Date Book. See the
section "Changing the displayed Start and End Times" later in this chapter.

Start Time

highlighted. Tap to scroll

to earlier

hours.

Tap to change

hours.

Tap to change

minutes.

Tap to scroll

to later hours.

6. Tap OK.

Scheduling a timed event for another date

1. Select the date you want in one of the following ways:
· Tap the desired day of the week in the date bar at the top of the screen. If necessary, tap the

Previous week or Next week scroll arrows to move to another week.
· Tap Go To at the bottom of the screen to open the Go to Date dialog box. Select a date by

tapping a year, month, and day in the calendar.
2. After locating the desired date, follow the steps for scheduling an event for the current day.

Scheduling untimed events

You can schedule untimed events for any date. Untimed events appear at the top of the list of times
marked with a diamond.
1. Select the event date you want, as described in the previous procedure, "To schedule a timed

event for another date."
2. Tap New.
3. In the Set Time dialog box, tap No Time.

NOTE
You can tap OK instead but make sure nothing is entered for start or end time.
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TIP
You can open the Set Time dialog box (to select a start time) by making sure no event is selected,
and then writing a number on the number side of the text input area.

4. Enter a description of the event.

5. Tap a blank area on the screen to deselect the untimed event.

NOTE
If you create a timed event and later want to make it an untimed event, tap directly on the event
time on the Date Book screen; then tap No Time and tap OK.

Scheduling repeating or continuous events

The Repeat function lets you schedule events that recur at regular intervals or extend over a period
of consecutive days. Repeating events include a birthday and a weekly guitar lesson that falls on the
same day of the week and the same time of day. Continuous events might include a business trip or
a vacation.
1. Tap the event (Be sure to tap the event and not the time next to the event).

Typically, a continuous event is an untimed event.

2. Tap Details.
3. Tap the Repeat box to open the Change Repeat dialog box.

Tap the

Repeat box
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4. Tap Day, Week, Month, or Year to set how often the event repeats. For a continuous event, tap
Day.

5. Enter a number that corresponds to how often you want the event to repeat on the Every line.
6. For example, if you select Month and enter the number 2, the event repeats every other month.
7. To set an end date for the repeating or continuous event, tap End on the pick list and tap

Choose Date. Use the date picker to select an end date.
8. Tap OK. An icon that represents a repeating event appears to the far right on the event line.

Changing repeating or continuous events

When changes are made to a repeating or continuous event you have the option of applying the
change to just the current event, the current event and all future occurrences of this event, or all
occurrences of this event - past, present, and future.
1. Select the event you want to delete.
2. Tap Details or the icon on the same line as the event. The Event Details screen opens.

Repeating or
Continuous Events

are shown with
this icon.

3. Tap Delete. The Repeating Event screen opens asking for confirmation of the delete.

TIP
You can also select Delete Event from the Record menu. This opens the Repeating Event sceen.

Tap delete

4. Select one of the following options:
· Current deletes a single occurence of this event.
· Future deletes the current event and all future occurences of this event.
· All deletes all past, current and future occurences of this event.

The event is removed from your date book and you are returned to the day view where you started.
These steps apply to all changes you make to repeating or continuous events.

Sheduling repeating or continuous event tips

Keep the following in mind when scheduling repeating or continuous events:
· If you change the start date of a repeating event, your RDA calculates the number of days you

moved the event. Your RDA then automatically changes the end date to maintain the duration of
the repeating event.

· If you change the repeat interval (e.g., daily to weekly) of a repeating event, past occurrences
(prior to the day on which you change the setting) are not changed, and your RDA creates a new
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repeating event.
· If you change the date of an occurrence of a repeating event (e.g., from January 14 to January 15)

and apply the change to all occurrences, the new date becomes the start date of the repeating
event. Your RDA adjusts the end date to maintain the duration of the event.

· If you change other repeat settings (for example, time, alarm, private) of a repeating event and
apply the change to all occurrences, your RDA creates a new event. The start date of this new
event is the day on which the setting is changed. Past occurrences (prior to the day of the change)
are not changed.

· If you apply a change to a single occurrence of a repeating event (e.g., time), that occurrence no
longer shows the Repeat icon.

Rescheduling events

You can reschedule events using the Details option in the Date Book. You can also use the Details
option to convert untimed events into timed events.

To reschedule an event:
· Tap the event you want to reschedule.
· Tap Details.
· To change the time, tap the Time box, select a new time, and then tap OK.
· To change the date, tap the Date box, select a new date, and then tap OK.

Adding Address Book information to an event

You can add a name, address, and telephone number to an event using the Phone Lookup option. For
instructions, see "Using Phone Lookup" in chapter 8, "Performing Common Tasks".

Setting the alarm

The Alarm setting lets you set an audible alarm for events in your Date Book, and display a reminder
message on-screen. For untimed events, only the reminder message appears.

Setting an alarm for an event

You can set an alarm for minutes, hours, or days before an event. When you set an alarm, an Alarm
icon appears to the far right of the event with the alarm.
You can also set a silent alarm for untimed events that displays a reminder message on-screen before
the day of the event. The alarm triggers at the specified period of minutes, hours, or days before
midnight of the day on which the untimed event begins.
For example, you set a 5-minute alarm for an untimed event that occurs on February 4. The reminder
message will appear at 11:55 p.m. on the night of February 3. The reminder remains onscreen until
you turn on your RDA and tap OK to turn off the reminder.
1. Tap the event to which you want to assign an alarm.
2. Tap Details.
3. Tap the Alarm check box to select it.
4. The default setting, 5 Minutes, appears.
5. Set the alarm time:

· Select the 5 next to the Alarm check box and enter any number from 0 to 99 (inclusive) as
the number of time units.

· Tap the pick list to change the time unit; select Minutes, Hours, or Days.
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Time bar

shows default
duration.

Enter number of

time units here.

6. Tap OK.

Once an alarm has gone off, you can tap the Snooze option to dismiss the alarm for a 5-minute
period.

To dismiss the alarm using the snooze option:
When the alarm dialog box appears, tap Snooze to delay the alarm for a preset five-minute period.
Each time you tap Snooze, the alarm is dismissed for an additional 5-minute period.

Setting alarm options

You can set the alarm to go off automatically for each new event using preferences. You can also set
a tone for the alarm and the number of times the alarm sounds.

To set alarm options:
1. To open the Preferences dialog box, do one of the following:

· In the Date Book, tap the Options icon.
· Tap the inverted tab at the top of the Date Book screen to display the menu bar.
· In the text input area, drag a diagonal line from the lower left to upper right to display the

Command toolbar. Type an R, the Graffiti® 2 ShortCut for the Preferences command.
2. In the Options menu; tap Preferences.

3. Select from the following options:
· Tap Alarm Preset to set an alarm for each new event automatically. The silent alarm for

untimed events is defined by minutes, days, or hours before midnight of the date of the
event.

· Tap Remind Me to define how many times the alarm sounds—once or twice; or three, five, or
ten times.
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· Tap Play Every to set how often the alarm sounds—every minute; or every 5, 10, or 30
minutes.

4. Tap OK.

Changing the Date Book view

The Date Book includes four views for displaying your appointments: day view, week view, month
view, and agenda view.

To display the Date Book views:
1. Do one of the following:

· Press the Date Book application button repeatedly to cycle through all the Date Book views.
· Tap a view icon in the lower-left area of the Date Book screen.

Date Book
view
icons

To display the current time:
Tap and hold down the stylus on the date in the date bar to display the time. (When you release the
stylus, the menu bar appears.)

Working in Week view

Week view displays a calendar of your events for an entire week. This view lets you quickly review
your appointments and available time slots. In addition, the graphical display helps you spot overlaps
and conflicts in your schedule.

Displaying the Week view

1. Tap the Week view icon or press the Date Book button until the Week view appears.

Week view

2. Tap the left and right navigation controls to move forward or backward a week at a time, or tap
on a specific day to display the details of an event.
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NOTE
The Week View also shows untimed events and events before and after the range of times
displayed.

Bar indicates later event.

Bar indicates earlier event.

Bar indicates earlier event.

Next
week

Previous
week

3. Tap an event to display a description of the event at the top of the screen.

Tap to show event details.

Event details.

Tips for using Week view

Keep the following points in mind when using Week view:
· To reschedule an event while in Week view, tap and drag the event to a different time or day.
· Tap a blank time on any day to move to that day and have the time selected for a new event.
· Tap any day or date that appears at the top of the Week view to move directly to that day without

selecting an event.
· The Week view displays the time span defined by the Start Time and End Time in the Date Book

Preferences settings. If you have an event before or after this time span, a bar appears at the top
or bottom of that day's column. Use the onscreen scroll arrows to scroll to the event.

Spotting event conflicts

With the ability to define specific start and end times for any event, it is possible to schedule events
that overlap (an event that starts before a previous event finishes).

An event conflict (time overlap) appears in the Week view as overlapping time bars and in the Day
view as overlapping brackets to the left of the conflicting times.

Event

conflicts.
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Working in Month view

The Month View screen shows which days have events scheduled. Dots and lines in the Month view
indicate events, repeating events, and untimed events.

Month view

icon.

Dashed line indicates continuous event.

Dots on right side indicate timed

events.

Previous/next month

Dots below date indicate untimed

events.

You can control the dots and lines that appear in the Month View. See
"Changing the Date Book display of events" for more information.

Tips for using Month view

Keep the following points in mind when using the Month view:
· Tap a day in the Month view to display that day in the Day view.
· Tap the scroll arrows in the upper right corner to move forward or backward a month.
· Tap Go To in order to open the date selector and select a different month.
· Use the scroll buttons on the front panel of your RDA to move between months. Press the top

button to display the previous month, the bottom button to display the next month.

Working in Agenda view

The Agenda view lets you view appointments, untimed events, and To Do List items in a single
screen. Although it is primarily a viewing option, you can also use the Agenda view to check off
completed To Do List items. To go to a Day View of any event on the Agenda view screen, simply tap
the desired event.

Displaying the Agenda view

1. Tap the Agenda view icon or press the Date Book button until the Agenda view appears.

Agenda view
icon.

2. Use the navigation bars to move forward or backward a day at a time or to display more To Do
items.
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Scroll the list

for each view

To Do List

items

Tips for using Agenda view

· Tap any appointment while in Agenda view to display the Day View of the appointment.
· Check off completed To Do List items in the Agenda view, or click a description of an item to go

directly into the To Do List application.
· You can change the category of To Do items shown. Tap on the pick list and select the new

category. See the chapter on "Using the To Do List" for more information on To Do items.

Changing the Date Book display

In Day or Month view, you can change which events appear in the Date Book. In Day view, you can
display time bars that highlight event conflicts.

To change the Date Book display of events:
1. In Day view or Month view, tap the Options icon.
2. Tap Options, and then tap Display Options.

3. For Day view, select from the following options:
· Tap Show Time Bars to display time bars showing the duration of an event and any event

conflicts.
· Tap Compress Day View to display start and end times for each event, but no blank time slots

at the bottom of the screen, to minimize scrolling. Clear the option to display all time slots.
4. For Month view, select whether to display Timed, Untimed, or Daily Repeating events.
5. Tap OK.

Changing the displayed Start and End Times

You can change the preferences used for new entries. Preferences include display starting time,
display ending time, and alarm characteristics. See the section "Setting alarm options" earlier in this
chapter for more information on alarm preferences.

To change the start and end time in the Date Book:
1. In the Date Book, tap the Menu icon.
2. Tap Option, and then tap Preferences.
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The Start and End Time are used by the various Date Book screens. The Day view schedules
events to start and end at these times when the All Day option is selected. The Week view
displays the time span defined by the Start Time and End Time.

3. Tap Start Time and use the scroll arrows to select a new start time for the Date Book screens.
Repeat the step to set a new end time. If the time slots you select do not fit on one screen, you
can tap the scroll arrows to scroll up and down.

4. Tap OK.



Using the Date Book (Working with Applications)

Using the To Do List

The To Do List is a convenient place to create reminders and prioritize the things you
have to do.

Use the To Do List to:
· Make a quick and convenient list of things to do.
· Assign a priority level to each task.
· Assign a due date for any or all of your To Do List items.
· Assign To Do List items to categories so that you can view them in logical groups. For more

information, see "Categorizing records" in chapter 8, "Performing Common Tasks".
· Sort your To Do List items either by due date, priority level, or category.
· Attach notes to individual To Do List items for a description or clarification of the task. For more

information, see "Attaching notes" in chapter 8, "Performing Common Tasks".
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Opening the To Do List

Tap the Home icon to access the Applications Launcher menu; then tap the To Do List icon to display
the category of items you last viewed.

Creating To Do List items

A To Do List item is a reminder of some task that you have to complete. A record in the To Do List is
called an item.

To create a To Do List item:
1. Press the To Do List button on the front of your RDA to display the To Do List.
2. Tap New.

Tap New.

New To
Do item.

3. Enter the text of the To Do List item.

TIP
You can add a name, address, and phone number to a To Do List item using the Phone Lookup
option. For more information, see "Using Phone Lookup" in chapter 8,
"Performing Common Tasks".

4. Tap anywhere onscreen to deselect To Do List item.

TIP
If no To Do List item is currently selected, writing in the text input area automatically creates a
new item.

Setting To Do List priorities

You can set priorities for tasks in your To Do List according to their importance or urgency. Items
appear by priority and due date at the top of the To Do List by default, with 1 the highest priority.
Changing an item's priority may move its position in the list.
New To Do List items automatically have a priority of 1. If you select another item first, before
creating a new item, the item you create appears beneath the selected item with the same priority as
the selected item.

1. If priorities aren't visible in the To Do List, tap Show at the bottom of the list, tap Show
Priorities, and tap OK.

2. Tap the Priority number on the left side of the To Do List item.
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Tap here.

Tap to

select
priority

3. Tap the Priority number that you want to set, with 1 the most important and 5 the least
important.

Checking off To Do List items

You can check off a To Do List item to indicate that you've completed it.
1. In the To Do List, tap show. Tap Show Completed Items. If you clear this setting, your To Do

items disappear from the list when you complete (check) them.

NOTE
Items that no longer appear on the list because Show Completed Items is turned off have not been
deleted. They are still in the memory of your RDA. You must purge completed items to remove
them from memory.

2. Tap the check box on the left side of the item.

Completed To
Do List item.

Changing priorities and due dates

You can change the To Do List to display the due date assigned to an item, change its priority, and
assign a category to the task with the To Do Item Details dialog box.
You can then sort To Do List items by priority, due date, or category.
1. In the To Do List, tap the item that you want to change.
2. Tap Details.
3. In the Details dialog box, tap No Date to open the Due Date pick list.

Tap here.

4. Tap the date that you want to assign the item. Options are Today, Tomorrow, One Week from
the current date, No Date to remove the due date from the item, or Choose Date to display the
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date selector and select a date. tomorrow's date.
5. Tap Private to hide this item when Security is turned on.
6. For more information, see "Making records private" in chapter 8, "Performing Common Tasks".
7. Tap OK.

TIP
If you turn on the Show Due Dates option in the To Do Preferences dialog box, you can tap directly
on the due date in the To Do List to open the pick list shown in step 2.

Sorting To Do items

1. In the To Do List, tap Show.
2. In the To Do Preferences screen, tap Sort By, and then select an option from the pick list:
3. Tap Priority, Due Date to sort items by priority first, and then due date. Tap Due Date, Priority to

reverse that order.
4. Tap Category, Priority to sort items by category first, and then priority. Tap Priority, Category to

reverse that order.
5. Tap OK.

Displaying completed and due items

You can have the To Do List display completed items and their
completion dates, as well as due items and their due dates.
1. In the To Do List, tap Show.

2. In the To Do Preferences dialog box, choose from the following settings:
· Tap Show Completed Items to display your completed items in the To Do List. If this setting is

turned off, completed To Do items disappear from the list, but are kept in the memory of your
RDA. You must purge completed items to remove them from memory.

· Tap Show Only Due Items to show only the items that are currently due, past due, or have no
due date specified. When this setting is active, items that are not yet due do not appear in
the list until their due date.

· Tap Record Completion Date to replace the due date with the actual date when you complete
(check) the item. If you do not assign a due date to an item, the completion date still records
when you complete the item.

· Tap Show Due Dates to display the due dates for items in the To Do List and to display an
exclamation mark next to items that remain incomplete after the due date passes.

3. Tap OK.
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Using the Address Book

The Address Book lets you keep names, addresses, telephone numbers, and other
information about your personal or business contacts.

Use the Address Book to:
· Quickly enter, look up, or duplicate names, addresses, phone numbers, and other information.
· Enter up to five phone numbers (home, work, fax, car, and so on) or e-mail addresses for each

name.
· Define which phone number appears in the Address List for each Address Book entry.
· Attach a note to each Address Book entry, in which you can enter additional information about the

entry. Assign Address Book entries to categories so that you can organize and view them in logical
groups.
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Opening the Address Book

Tap the Home icon to access the Application Launcher menu; the tap the Address Book icon to display
the list of all your records.

Adding and using Address Book entries

The Address Book application stores name and address information about people or businesses.

Creating an Address Book entry

A record in Address Book is called an entry. You can create entries on your RDA, or you can use Palm
Desktop to create entries on your computer and then download them to your RDA with your next
HotSync operation.
Palm Desktop also has data import capabilities that let you load database files into the Address Book
on your RDA.
See the section entitled "Importing data" in chapter 2 and Palm Desktop online Help for more
information.

To create a new Address Book entry:
1. Tap the Home icon to display the Application Launcher menu; then tap the Address Book icon to

display the Address List.
2. Tap New.

Tap New.

Cursor at

Last name.

3. Enter the last name of the person you want to add to your Address Book.
4. Tap the First Name field to move to it.
5. You can move to any field by tapping it directly.
6. Enter the individual's first name in the First Name field.
7. If you want to be able to sort the Address Book by company name, enter the information you

want in the Company field.
8. Enter any other information that you want to include in the entry.
9. Tap the scroll arrows to move to the next page of information.
10. To attach a note to an entry, tap Note. Enter the information you want in the text input area,

and then tap Done.
11. When you have finished entering information, tap Done.
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Tap Done.

TIP
To create an entry that always appears at the top of the Address List, begin the Last name or
Company field with a symbol, as in *If Found Call.* This entry can contain contact information in
case you lose your RDA.

Viewing details of an address entry

1. Tap the address entry in Address List view. The entry appears in Address view.
2. Tap Done when you have finished viewing the entry.

Tap here to

view full

address details

Duplicating an entry

You can duplicate existing entries, which can be helpful when you want to enter multiple people from
a single organization. When you duplicate an entry, the word Copy appears next to the name in the
First Name field.
1. From the Address Book, tap a name you want to duplicate.
2. Do one of the following:

· Tap the Address Edit tab at the top of the screen; then tap Duplicate Record in the Record
menu.

· In the text input area of your device's screen, drag a diagonal line from the lower left to
upper right to display the Command toolbar; then write a T in the text input area to initiate
the Duplicate Record command.

3. Edit the record as necessary.

Selecting different types of phone numbers and addresses

You can select the types of phone numbers or e-mail addresses that an Address Book entry displays.
Any changes you make apply only to the current entry.
1. Tap the entry that you want to change in the Address list.
2. Tap Edit.
3. Tap the pick list next to the label you want to change.
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Tap triangle.

4. Select a new label.

Editing Address Book entries

You can change the type of information that appears in the Address List screen, categorize an entry,
and hide an entry for security reasons. You can also delete entries.
1. Tap the entry that you want to change in the Address List.
2. Tap Edit.
3. Tap Details.

4. In the Address Entry Details dialog box, select any of the following settings:
· Tap Show in List, and in the pick list tap which type of phone or other information you want to

appear in the Address List screen. Options are Work, Home, Fax, Other, and E-mail.
· Tap Category, and then tap a category in the pick list that you want to assign to the entry.
· Tap Private to hide the entry when Security is turned on.

5. To attach a note to the entry, tap Note, enter information in the text input area, and tap OK.
6. To delete the entry, tap Delete.
7. Tap OK.

Changing the Address Book display

You can change how Address Book lists are sorted and you can add custom fields for entering
additional information, using preferences. You can also have the Address Book display the last
category you selected each time you return to the application.
1. In the Address list or in Address view.
2. Tap the Options icon.
3. Tap Options, and then tap Preferences.
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4. Choose an option to sort Address Book lists from the List By pick list:
· Tap Last Name, First Name to sort alphabetically by an individual's last anem and then first

name.
· Tap Company, Last Name to sort alphabetically by the company name, and then an

individual's last name.
5. Tap OK.

Adding custom fields at the end of Address Edit screens

1. In the Address list or in Address view, tap the Options icon.
2. Tap Options, and then tap Rename Custom Fields.

3. In the text input area, rename the fields to identify the information you'll enter in them. The
names you give the custom fields appear in all entries, at the end of the Address Edit screen.

4. Tap OK in the Rename Custom Fields dialog box.
5. Tap Done.

Controlling the Address Book display on returning to the application

1. In the Address list or in Address view, tap the Options icon.
2. Tap Options, and then tap Preferences.

3. In the Address Book Preferences dialog box, select an option:
· To have the Address Book redisplay the last category you selected on returning to the

application, tap the Remember Last Category check box to select it.
· To have the Address Book display the All category on returning to the application, tap the

Remember Last Category check box to clear it.
4. Tap OK.
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Using the Memo Pad

The Memo Pad provides a place to take notes that are not associated with records in the
Date Book, Address Book, or To Do List.

Use the Memo Pad to:
· Take notes or write any kind of message on your connected organizer.
· Drag and drop memos into popular computer applications like Microsoft® Word when you

synchronize using Palm Desktop and HotSync® technology.
· Assign memos to categories so that you can organize and view them in logical groups.
· Write down phone numbers and other types of information. Later, you can copy and paste this

information into other applications.
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Opening the Memo Pad

Tap the Home icon to access the Applications Launcher menu; then tap the Memo Pad icon. The
Memo Pad opens to display the last Memo Pad screen that you viewed.

Creating memos

A record in the Memo Pad is called a memo. A memo can contain up to 4,000 characters. The number
of memos you can store is limited only by the memory available on your RDA.
When you create a new memo, you can add information to it from the Address Book application, such
as a phone number or address, using the Phone Lookup option. See "Using Phone Lookup" in chapter
8, "Performing Common Tasks".

1. Press the Memo Pad button on the front of your RDA to display the Memo List.
2. Tap New.

Tap New.

TIP
You can also create a new memo by beginning to write in the text input area in the Memo List
screen. The first letter is automatically capitalized and begins your new memo.

3. Enter the text you want to appear in the memo. Use the carriage return stroke to move down to
new lines in the memo.

4. Tap Done.

You can categorize memos and sort them by categories. See "Categorizing Records" and
"Sorting Records" in chapter 8, "Performing Common Tasks" for more information.

Reviewing memos

The Memo List displays the first line of a memo. This makes it easy to locate and review your memos.
You can easily sort memos in the Memo List or move through memos using Memo options.
1. In the Memo List, tap the text of the memo.

Tap a memo

to review it's

contents

2. Review or edit the text in the memo.
3. Tap Done.
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Moving through a memo you’re reviewing

1. In the Memo List, tap the text of the memo you want to review.
2. Tap the Options icon.
3. Tap Options.
4. Tap one of the following options to go to the beginning or end of the memo:

· Tap Go to Top of Page to move to the top (first) line of the memo.
· Tap Go to Bottom of Page to move to the bottom (last) line of the memo.

Changing the order in which memos appear in the Memo List

1. In the Memo List, tap the Options icon.
2. Tap Options.
3. Tap Preferences, and choose one of the following options:

· Tap Manual to sort new memos in the sequence in which you create them.
· Tap Alphabetical to sort new and existing memos in numerical and then alphabetical

sequence.
4. Tap OK.
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Using the Calculator

The Calculator lets you perform general mathematical functions, such as addition,
subtraction, multiplication, and division.

Use the Calculator to:
· Perform basic calculations.
· Store and retrieve values.
· Display the last series of calculations, which is useful for confirming a series of "chain" calculations.
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Opening the Calculator

Tap the Calculator icon next to the text input area.

Using the Calculator buttons

The Calculator includes several buttons to help you perform calculations.

The CE button clears the last number you entered. Use this button if you make a
mistake while entering a number in the middle of a calculation. This button enables you
to re-enter the number without starting the calculation over.

The C button clears the entire calculation and enables you to begin a fresh calculation.

The Plus/Minus button toggles the current number between a negative and positive
value. If you want to enter a negative number, enter the number first and then press
the +/- button.

The M+ button places the current number in memory. Each new number you enter with
the M+ button is added to the total stored in memory. The number that you add can be
either a calculated value or any number you enter by pressing the number buttons.
Pressing this button has no effect on the current calculation (or series of calculations); it
merely places the value into memory until it is recalled.

The MR button recalls the stored value from memory and inserts it in the current
calculation.

The MC button clears any value that is stored in the Calculator memory.

Displaying recent calculations

The Recent Calculations command lets you review the last series of calculations and helps you confirm
a chain of calculations.
1. In the Calculator application, tap the Options icon.
2. Tap Options, and then tap Recent Calculations.
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3. When you have finished reviewing the calculations, tap OK.
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Using the Attention Manager
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Part V
Using the Attention Manager

Many applications (such as Date Book) want to get your attention with some sort of alarm. Attention
Manager allows you to conveniently manage all of these notifications in one place. Appointments and
messages can stack up while you are away from your device. Attention Manager lets you view them
from a single list, where you can selectively dismiss or follow up on each event.

Applications will signal for your attention at two different levels: insistent and subtle. Each will be
discussed in detail below.

Insistent alarms

Insistent applications open a Reminders dialog screen, and may play a sound. Alarms continue until
you snooze or dismiss them. If the sound can be interrupted, you can tap anywhere on the screen, or
push any button to silence it. Attention Manager will always open immediately when new insistent
alarms are posted.

Using the Reminder dialog screen

The Reminder dialog screen has three buttons for responding to an alarm:
OK: Makes the reminder go away, with no further notification.
Snooze: Switches to the application that was running when the alarm went off, and returns to the

Reminder dialog screen after five minutes. You can go back to the Reminder dialog screen
right away by tapping on the blinking indicator in the upper left corner of the screen. For
more information, see "Understanding the blinking alarm indicator" below.

Go To: Switches to the application that created the alarm, and shows the record that caused the
alarm, although you may have to navigate within the application. There is no further
notification.

Setting alarm volume

You control most alarm volumes globally in the General panel of the Prefs menu:
· Tap the Home icon to access the Applications Launcher, tap the Prefs icon.
· From the picklist in the top right corner of the screen, Tap General.
· Set the volume using the Alarm Sound pick list.
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Setting alarm sound effects

Some applications allow you to set the song or sound effect to use, and how many times to play it,
with a pause in between. For example, to set alarm preferences for the Date Book, do the following:
1. While displaying the Date Book application, tap the Options icon.
2. Tap the Options menu, and select Preferences.
3. Tap the Alarm Preset check box, if you want alarms to sound, then select the following from the

pick lists:
· 'Alarm Preset' - How soon you want the alarm to sound before the event
· 'Alarm Sound' - The alarm song or sound effect (for example, Bird or Concerto)
· 'Remind Me' - How many times the alarm repeats before giving up
· 'Play Every' - The pause between each time the alarm sounds

Using the Reminders list screen

The Reminders dialog screen changes to a list of items that require your attention under two insistent
alarm conditions:
· When a second application attempts to get your attention and the first has not been dismissed or

snoozed.
· When a first application makes a second attempt and the first has not been dismissed or snoozed.

Each listed reminder contains the date and time of the event. Depending on the application displaying
the reminder, you may see an icon representing the application, and up to two lines of text.

Tapping on the text or icon will "Go To" that item and delete the event from the Reminders list
screen.

Tapping in the check box will clear that item, similar to a To Do list item. The Attention Manager will
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draw a line through the text lines, pause for a moment, and them remove the item from the list,
although the original data remains in the application.

The Reminders list screen displays three buttons that are used to respond to all of the items
in the list:
Snooze: Puts the Reminders list screen to sleep for five minutes. After this time interval, the

Reminders list screen is displayed again. You can go directly to the Reminders list screen
without waiting, by tapping on the blinking alarm indicator. For more detail, see
"Understanding the blinking alarm indicator" below.

Done: If the Reminders list appeared because of more than one insistent alarm, tapping Done
closes the Reminders list screen, although the events will remain in the application that
created them. The Reminders list screen will not appear again, unless you tap the
blinking alarm indicator in the menu bar.

If the Reminders list appeared after you tapped the Snooze button, then tapped the
blinking alarm indicator, then tapped the Done button, the reminder will continue to
snooze.

For more detail, see "Understanding the blinking alarm indicator" below.

Clear All: removes all of the items from the list, but does not close the Reminders screen. Tap this
button to erase a list of events that have passed.

Subtle alarms

Some applications provide a visual, and optionally audible indication, but do not otherwise disrupt
your work flow. Subtle alarms do not display a Reminders screen. Instead, a blinking indicator will
flash in the upper left corner of the title bar (of applications that allow it) when an alarm is present.

Understanding the blinking alarm indicator
A blinking alarm indicator appears in the upper left corner of the screen in the menu bar (of
applications that allow it) under the following conditions:
· While viewing a Reminders dialog screen, you tap the Done or the Snooze button.
· A subtle alarm is present.

The indicator appears in three different states:
Off: The indicator is not shown at all when the list is empty.

Blinking, two states: When the list is not empty but there are no new items, then the "star"
indicator will blink on and off until the list has been emptied.

Blinking, three states: When a new subtle alarm is received the alarm indicator will alternate
flashing solid, exploded, then off, until you view the new event.



Subtle alarms (Using the Attention Manager)

Tapping on the indicator opens the Attention Manager in list mode, even if there is only one item.
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Part VI
Using an Expansion Card

Use the expansion card to:
· Backup and restore data to ensure your data is safe in the event of handheld crashing or being

damaged
· To store program applications

IMPORTANT
The CompactFlash® expansion slot will only permit Type I CompactFlash cards. For a list of
compatible CompactFlash cards, please contact Aceeca.

Displaying contents of the expansion card

When an expansion card is inserted, all applications listed in the card's launcher directory is
automatically added to a new Launcher category. This category is assigned the name of the
expansion card volume; for example, the name "My Card" is used throughout this section.

To display the contents of your expansion card:
1. Tap the Home icon to access the Applications Launcher menu.
2. Tap the All pick list in the upper right corner of the screen.

3. Tap the name of the expansion card on the menu (e.g. "My Card", as pictured above). The
applications residing on the expansion card are displayed on the Applications Launcher menu.
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Launching an application from the expansion card

To launch an application from the expansion card:
1. Press the Home icon to access the Applications Launcher menu.
2. Tap the All pick list in the upper right corner of the screen.

3. Tap My Card on the picklist.
4. The expansion card applications are displayed on the Applications Launcher menu.
5. Tap the application that you want to launch. The selected application is loaded into memory

(RAM) and launched. If the application is already resident in RAM, it is not loaded again, just
launched.

Displaying application information from the expansion
card
To display information about an application from the expansion card:
1. Press the Home icon to access the Applications Launcher menu on the front of your Meazura™

MEZ1000.
2. Tap the Options icon to bring up the App menu.

3. Tap Info.
4. In the Device pick list, tap My Card. The size of the applications on My Card are displayed.

5. To display the application version, tap version.
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TIP
When you tap More, you access the CardInfo application, described in the Using CardInfo section.

Copying an application to your expansion card or
handheld
To copy an application onto your handheld or your expansion card:
1. Press the Home icon to access the Applications Launcher menu.
2. Tap the Options icon to bring up the App menu.

3. Tap Copy.
4. Select the destination and the source using the Copy To and the From pick lists.

5. Select the application and then tap Copy.

The application is then copied to the selected destination.

6. Tap Done when you are finished.

TIP
Some applications and databases are copy-protected and cannot be beamed. These are listed with
a lock icon next to them.

Beaming an application from the expansion card

To beam an application from your expansion card to another Palm OS handheld:
1. Tap the Home icon to access the Applications Launcher menu.
2. Tap the Options icon to bring up the App menu.
3. Tap Beam.
4. Select 'My Card' from the 'Beam From' pick list.
5. Select the application you want to beam, then tap 'Beam'
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The RDA will then beam the application to the nearest IrDA enabled Palm OS handheld.

6. Once the application has finished beaming, you can tap 'Done' to exit.

TIP
Some applications and databases are copy-protected and cannot be beamed. These are listed with
a lock icon next to them.

Deleting an application from the expansion card

To delete an application from your expansion card:
1. Tap the Home icon to access the Applications Launcher menu.
2. Tap the Options icon to bring up the App menu.
3. Tap Delete.
4. Select My Card from the Delete From pick list.
5. Tap the application you want to delete, then tap Delete.

The application is deleted. Applications that are loaded in ROM (for example, Memo Pad) cannot
be deleted, and are not listed.

6. Once you have deleted your aplication, you can tap Done to exit.

Using CardInfo

To use Card Info:
1. Tap the Card Info icon on the Applications Launcher menu.

The Card Info Application displays summary information for each known directory type
found on the Meazura™ MEZ1000.

The expansion card properties are displayed
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To rename the expansion card:
1. To rename the expansion card, tap on the Card Info tab in the upper left corner of the screen.
2. Select Rename Card, and enter the new name in the Rename Card dialog box.
3. Tap the Rename button.

To reformat the expansion card:
1. To reformat the expansion card, tap Card Info, select Format Card, and tap OK in the Format

Card dialog box.

NOTE
Reformatting the expansion card will destroy its data.

To display more help in using Card Info:
1. Tap the Card Info tab in the upper left corner of the screen.
2. Select Help from the menu, and scroll through the tips that are displayed.
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Part VII
Performing Common Tasks

The tasks described in this section use the term record to refer to an individual item in any of the
basic applications, for example, a single Date Book event, Address Book entry, To Do List item, or
Memo Pad memo.

Creating records

You can use the following procedure to create a new record in Date Book, Address Book, To Do List,
and Memo Pad.

To create a record:
1. Select the application in which you want to create a record.
2. Tap New. (For the Date Book only, select start and end times for your appointment and tap OK.)
3. Enter text for the record.

NOTE
The RDA automatically capitalizes the first letter of each field (except numeric and e-mail fields).

4. As an option, tap Details to select attributes for the record.
5. In the Address Book and Memo Pad only, tap Done.

Your RDA saves the new record automatically.

Editing records

After you create a record, you can change, delete, or add new information at any time. When the
screen is in edit mode, a blinking cursor appears within the information, and the information appears
on a dotted gray line called an edit line.

You can enter text in any of the ways described in chapter 2,
"Entering Data in your Meazura™ MEZ1000 RDA".

Cursor

Edit line
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Selecting Text

Select the text you want to edit using one of the following techniques:
· Double-tap on a word in a field to select the word.
· Triple-tap on any word on a line to select the entire line.
· Drag across a line of text to select some or all of the information, or drag down to select text

across multiple lines.

Using the Edit menu

The Edit menu is available from any screen where you enter or edit text. As a general rule, the Edit
menu commands affects selected text. You can display the Edit menu in three ways: by tapping the
Menu icon, by tapping the inverted tab at the top of the screen, and by writing a Graffiti® 2
ShortCut.

1. Once you are in an application (such as Date Book, To Do List or Memo Pad), do one of the
following to display the Edit menu:
· Tap the Options icon; then tap the Edit menu to display the commands in the menu.
· Tap the inverted tab at the top left of the screen; then tap the Edit menu to display the

commands in the menu.
· In the text input area, drag a diagonal line from the lower left to upper right to display the

Command toolbar. To select a command, either tap the icon representing a command on the
Command toolbar, or draw the Graffiti 2 ShortCut in the text area of your screen.

2. Choose from the following commands, depending on the application you're using:
· Undo reverses the last action taken.
· Cut removes a selection from its current location to memory. You can then paste the text into

another area of the current application or into a different application.
· Copy copies a selection and moves it to memory. You can paste the selection into another

area of the current application or into a different application.
· Paste inserts a selection from memory into an area you select. Paste produces no result if you

have not used the Cut or Copy commands.
· Select All selects all the text in the current record or screen.
· Keyboard opens the onscreen keyboard. Tap Done to close the keyboard.
· Graffiti 2 Help opens the Graffiti 2 character stroke screen.

Deleting records

You can delete records in any of the basic applications.
1. Select the record you want to affect.
2. Do one of the following:

· Tap the Options icon, open the Record menu, and then tap the Delete command.
· The Delete command differs depending on the application you're using, for example, Delete

Event appears in the Record menu while you're in the Date Book, and Delete Item appears
when you're using the To Do List.

· Tap the inverted tab at the top left of the screen, open the Record menu, and then select the
desired Delete command.

· In the Details dialog box of the application, tap Delete, and then tap OK (If you are deleting
an Address Book record, you will need to tap Edit prior to this step).

· Delete the text of the record.

NOTE
In the Date Book, deleting the text of a repeating event deletes all instances of the event.
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· In the text input area, drag a diagonal line from the lower left to upper right to display the
Command toolbar; then tap the Delete icon or draw a Graffiti 2 'D' in the text area.

Delete icon

A confirmation dialog box appears.

3. To archive a copy of the deleted file on your PC, select the Save Archive option. If you choose
the archive option, the record is transferred to the archive file on your PC the next time you
perform a HotSync operation.

NOTE
If you are using multiple users on Palm Desktop, the archive copy will only be saved under the
HotSync ID that the record was originally.

4. Tap OK to delete the record.

Purging records

Over time, as you use Date Book and To Do List, you may accumulate records that are no longer
useful. For example, events that occurred months ago remain in the Date Book, and completed To Do
List items remain in the list.

Outdated records take up memory on your RDA, so it's a good idea to remove them by using Purge.
If you think Date Book or To Do List records might prove useful later, you can purge them from your
RDA and save them in an archive file.

Purging is not available in Address Book or Memo Pad; delete records from these applications
manually.
1. Open the application from which you want to purge records.
2. Choose from the following options:

· Tap the Options icon, open the Record menu, and then tap Purge. A confirmation dialog box
appears.

· Tap the inverted tab at the top left of the screen, open the Record menu, and select Purge.
3. Choose from the following options:

· For the Date Book, select the Delete Events Older Than pick list and select an option—1 week,
2 weeks, 3 weeks or 1 month.

· For the Date Book or To Do list, select Save Archive Copy on PC to save a copy of purged
records in an archive file on your desktop. Selecting this option transfers purged records to an
archive file the next time you perform a HotSync operation. Tap OK.

Categorizing records

You can categorize records in the Address Book, To Do List, and Memo Pad for easy retrieval. (The
Date Book does not have categories.) When you create a record, it is automatically assigned to the
currently displayed category. For example, if the All category is displayed, the record is assigned to
the Unfiled category. A record can remain unfiled or it can be assigned to a category at any time.

Each application has a default set of categories:
· The Address Book includes a Business, Personal, and QuickList category.
· The To Do List includes a Business, Personal, and All category.
· The Memo Pad includes a Business, Personal, and All category.

You can rename or delete the default categories, and you can create new categories. Each application
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can have up to 15 categories.

To move a record into a category:
1. Select the record you want to categorize.
2. Tap Details. (From the Address View screen, tap Edit first.)
3. In the Details dialog box, tap the Category pick list, select the desired category, and then tap

OK.

To display a category of records:
1. Open one of the following applications: the Address Book, the To Do List, or the Memo Pad

application.
2. Tap the pick list in the upper right corner of the screen; then tap the category you want to

display.

Tap pick list Select a category

TIP
Pressing the Address Book, To Do List, or Memo Pad button on your RDA toggles through the
categories assigned to the application, respectively.

To edit application categories:
1. In the Address Book, To Do List, or Memo Pad application, choose from the following options:

· Tap the pick list in the upper right corner of the screen, and tap Edit Categories.

Tap here

· In the Address Book, select a record and tap Edit; then tap Details. In the Category pick list,
tap Edit Categories.

· In the Memo Pad and To Do List, select a record from the list, and tap Details. In the Category
pick list, tap Edit Categories.

To add or delete application categories:
1. In the Address Book, To Do List, or Memo Pad application, choose from the following options:
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· Tap the pick list in the upper right corner of the screen, and tap Edit Categories.

Tap here

· In the Address Book, select a record and tap Edit; then tap Details. In the Category pick list,
tap Edit Categories.

· In the Memo Pad and To Do List, select a record from the list, and tap Details. In the Category
pick list, tap Edit Categories.

2. Select any of the following options:
· To create a new category, tap New, and enter a new name in the text input area. Tap OK.

· To delete a category, tap it in the list to select it. Tap Delete.

3. Tap OK.

To rename a category:
1. Tap the pick list in the upper right corner of the screen; then tap Edit Categories.

2. Select the category you want to rename; then tap Rename.
3. Enter the new name for the category, and tap OK.
4. Tap OK to exit the Edit Categories dialog box.

TIP
You can move records from multiple categories into a single category by renaming all discrete
categories with a single category name.

Finding records

Your RDA lets you find information in several ways:
· In all applications, starting with the current application, you can locate selected text.
· In the Date Book, the To Do List, and the Memo Pad, you can use Phone Lookup to display the

Address List screen and add the information from this list to a record.
· In the Address Book, you can use the Look Up option to enter the first letters of a name to scroll
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immediately to that name.

Finding Address Book records
You can look up Address Book records using the scroll button on the front panel of your device or by
typing the first few letters of a name in the Look Up option at the bottom of the address screen.

To look up an Address Book record:
1. Do one of the following:

· From the Address screen, enter the first few letters of the name you want to locate.

Look Up option

· Use the scroll button on the front of the device to scroll a screen at a time. Holding down the
scroll button accelerates scrolling.

Using the Find option
The Find option lets you locate text in any or all applications. For example, if the text "dog" appears
in the Address Book and the Date Book, the Find option displays both occurrences in the Find dialog
box.
1. Tap the Find icon.
2. Enter the text you want to find; then tap OK.

Note that the Find option is not case sensitive; searching for "davidson" also finds "Davidson."

TIP
Select text in an application before tapping Find to automatically place the text in the Find dialog
box.

Find searches for the text in all records and all notes within all applications.

As your RDA searches for the text, you can tap Stop to stop the search at any time. To continue
the search after tapping Stop, tap Find More.

NOTE
Find will locate all matches that begin with the supplied text. It will not find words where the
supplied text appears in the middle or at the end of a word.
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Using Phone Lookup
The Phone Lookup option lets you add a telephone number from the Address list to an entry in
another application. For example, you can add your dentist's telephone number to your dental
appointment date in the Date Book.

1. Display the record in which you want to insert a phone number. The record can be in the Date
Book, the To Do List, or the Memo Pad.

2. Do one of the following:
· Tap the Menu icon. Tap Options, and then tap Phone Lookup.
· Tap the inverted tab at the top of the screen; then tap Options and tap Phone Lookup.
· In the text input area, drag a diagonal line from the lower left to upper right to display the

Command toolbar. In the text area, write an L, the ShortCut for the Phone Lookup command.
3. Select a record or write the first few letters of the name you want to add. Tap Add to add the

information to the record.

TIP
You can automatically replace text from any of the standard applications discussed in this manual
with the name and phone number found within your Address Book using Phone Lookup. Just place
your cursor or drag and highlight a section of text you want to replace, then follow step 2 above.
When the search is complete, the name and phone number of the candidate will be added.

Sorting records

You can sort lists of records in various ways, depending on the application. Sorting is available in
applications that display lists—in the Address Book, To Do List, and Memo Pad.

To sort records in the To Do List :
1. Open the application to display the list screen.
2. Tap Show.
3. Tap the Sort By pick list, and select an option.

4. Tap OK.

To sort records in the Address Book and Memo Pad:
1. Open the application to display the list screen.
2. Do one of the following:

· Tap the Options icon. From the Options menu, tap Preferences.
· Tap the inverted tab at the top of the screen; then tap Preferences in the Options menu.
· In the text input area, drag a diagonal line from the lower left to upper right to display the

Command toolbar. In the text area, write an R, the ShortCut for the Preferences command.
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Address Book

Preferences

Tap here

Memo Pad

Preferences

3. In the Preferences dialog box, tap the option you want; then tap OK to sort the list.

To sort the Memo List manually:
1. In Memo Pad, display Memo Pad preferences as above and tap Manual and tap OK.
2. Tap and drag a memo to a new location in the list.

TIP
To display the list of your memos on your computer as you arranged them manually on your RDA,
open Memo Pad in Palm Desktop click Sort By, and select Order on Handheld.

Making records private

In all the basic applications, you can make individual records private. Private records can be either
masked or hidden. Private records remain visible and accessible until you select a security setting to
Hide records. Private record names are covered with a gray bar when the security setting is set to
Mask records.

If you have assigned a password to your device, you must enter it before private records are
displayed. See "Assigning security options" in chapter 3, "Managing Applications" for more
information.

1. In your application, do one of the following:
· Create a new record and tap Edit, and then tap Details.
· Select an existing record, and tap Details.

2. Tap the Private check box. Tap OK.
3. At the alert in the Private Records dialog box, tap OK.

To hide private records:
1. Do one of the following:

· Tap the Home icon to access the Applications Launcher menu; then tap the Security
application.

· From within an application, tap the inverted tab at the top left of the screen; then tap
Security in the Options menu.

· From within any application, bring up the Command Bar and tap the padlock icon. To bring up
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the Command Bar, drag your pen diagonally across the text input area from lower left to
upper right.

2. In the Change Security dialog box, in the Current Privacy pick list, tap Hide Records; then tap
OK.

To display private records:
1. Do one of the following:

· Tap the Home icon to access the Applications Launcher menu; then tap the Security icon.
· From within an application, tap the inverted tab at the top of the screen; then tap Security in

the Options menu.
· From within any application, bring up the Command Bar and tap the padlock icon. To bring up

the Command Bar, drag your pen diagonally across the text input area from lower left to
upper right.

2. From the Current Privacy pick list, tap Show Records; then tap OK.
3. If you have assigned a password, you must enter the password before the hidden records are

displayed.
4. Enter your password, and then tap Show.

Attaching notes

You can attach notes to records in all the basic applications except the Memo Pad. A note can be up
to several thousand characters long.

1. Display the entry to which you want to add a note.
2. In Address Book only, tap Edit.
3. Tap Details.
4. Tap Note; then enter the desired note.
5. Tap Done.

A note icon appears to the right of any item containing a note.

Note icon

To review or edit a note:
Tap the note icon.

To delete a note:
1. Tap the note icon.
2. Tap Delete; then tap Yes to delete the note.



97

Choosing fonts

You can change the font style in all basic applications. You can choose a different font style for each
application.

Small font Large font

Bold font

Changing the font style
1. Open an application.
2. Do one of the following:

· Tap the Options icon. From the Options menu, tap Font.
· Tap the inverted tab at the top left of the screen; then tap Font in the Options menu.
· In the text input area, drag a diagonal line from the lower left to upper right to display the

Command toolbar. In the text area, write an F, the ShortCut for the Font command.
3. Tap the font style you want; then tap OK.

Tap here for small font

Tap here for bold font

Tap here for large font

Getting information on an application

You can get information on any application by displaying its About box. The About box displays the
name and version number of the application.

To display the About box:
1. Tap the Options icon from any location.
2. In the Options menu, tap About.
3. The text following the About command differs based on your location. For example, if you're in

the Date Book, the command is About Date Book; if you are in the Address Book, the command
is About Address Book.
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Part VIII
Beaming Information

Your Meazura™ MEZ1000 RDA is equipped with an IR (infrared) port that you can use to beam
information to another Aceeca connected device that's close by and also has an IR port. The IR port is
located at the top of the RDA, behind the small dark shield.

You can beam the following information between Aceeca connected organizers:

· The record currently displayed in Date Book, Address Book, To Do List, or Memo Pad.
· All records of the category currently displayed in the Address Book, To Do List, or Memo Pad

applications.
· A special Address Book record that you designate as your business card, containing information

you want to exchange with business contacts.
· An application installed in RAM memory.

NOTE
HotSync operations can also be done using the IR port. See "IR HotSync operations" in chapter 11
for more information.

For best results, Meazura™ MEZ1000 RDA's should be between 10 centimeters (approximately 4
inches) and 1 meter (approximately 39 inches) apart, and the path between the two devices must be
clear of obstacles. Beaming distance to other Aceeca connected devices may be different.

Beaming a business card

To select a business card for beaming:
1. Tap the Home icon to access the Applications Launcher menu.
2. Tap the Address Book icon.
3. In the Address List, create a new entry or select an entry that contains the information you want

on your business card. See "Adding and using Address Book entries" in
"Using the Address Book" for more information.

4. In Address View, tap the Options icon and tap Record. Then tap Select Business card.
5. At the prompt, tap Yes.

Beaming a record

To beam a record, business card, or category of records:
1. From within Address Book, Date Book, Memo Pad or To Do List;
2. Locate the record, business card, item, memo or category you want to beam.
3. Tap the Options icon.
4. Tap Record.
5. Choose from the following options:

· Depending on the application you are in, you can choose to beam an item, category, business
card, event, etc.

· Use the Graffiti® 2 Command stroke /B to beam the current entry.
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NOTE
You can set the full-screen pen stroke to beam the current entry. See "Changing what the full-
screen pen stroke activates" in chapter 3 for more information.

6. When the Beam Status dialog box appears, point the IR port directly at the IR port of the
receiving RDA.

After the beaming process is finished, the dialog box will automatically close.

Beaming an application

To beam an application:
1. Tap the Home icon to access the Applications Launcher menu.
2. Tap the Options icon.
3. Tap App, and then tap Beam...
4. Tap the application you want to transfer, and tap Beam.

NOTE
Some applications are copy-protected and cannot be beamed, as indicated by a lock icon.

5. When the Beam Status dialog box appears, point the IR port directly at the IR port of the
receiving RDA.

After the beaming process is finished, the dialog box will automatically close.

Receiving beamed information

To receive beamed information:
1. Turn on your RDA.
2. Point the IR port directly at the IR port of the transmitting RDA to open the Beam Status dialog

box.
3. If you wish to store the beamed information onto your handheld, tap Yes to accept otherwise tap

No.
4. Incoming records are placed in the Unfiled category.

Turning off beaming

To turn beaming on or off:
1. Tap the Home icon to access the Applications Launcher menu.
2. Tap the Prefs icon.
3. In the pick list in the upper right corner, tap General.
4. In the General Preferences screen, tap the Beam Receive pick list, and then tap On or Off to

select the option.
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Part IX
Exchanging and Updating Data using

HotSync® Operations

HotSync® technology lets you synchronize — exchange and update data between one or more
Aceeca connected organizers and Palm Desktop or another PIM such as Microsoft Outlook. To
synchronize data, you must connect your Meazura™ MEZ1000 RDA and Palm Desktop by directly
placing your RDA in the cradle or communications cable attached to your desktop computer.

The HotSync process automatically synchronizes data between your RDA and Palm Desktop. Changes
you make on your RDA or Palm Desktop appear in both places after a HotSync operation. HotSync
technology synchronizes only the needed portions of files, thus reducing synchronization time. This
chapter describes how to select HotSync options and perform a HotSync operation via the
cradle/cable.

Performing a HotSync operation for the first time

The first time you synchronize your data, you must enter user information on both the RDA and Palm
Desktop. After you enter this information and synchronize, the HotSync Manager recognizes your RDA
and doesn't ask for this information again.

If you are a System Administrator preparing several RDA's for a group of users, you may want to
create a user profile. See "Creating a user profile" later in this chapter before performing the
following steps.

Creating a user profile

You can create a user profile to load data into an RDA without associating that data with a user name.
This feature lets System Administrators configure several Aceeca RDA's with specific information
(such as a company phone list) before distributing them to their actual users. On Windows, you use
the File Link feature of the Palm Desktop to import information from external files. For more
information see "Using File Link" later in this chapter. On the Macintosh you can use the File > Import
menu item on the Palm Desktop for this purpose.

The User Profile feature is designed only for the first-time HotSync operation, before you assign a
User ID to a particular RDA.

To create a user profile on Windows:
1. Open Palm Desktop.
2. From the Tools menu, choose Users.
3. Click Profiles.
4. Click New. Enter a unique name for the profile and click OK.
5. Click OK to return to Palm Desktop.
6. Select the profile from the User list and create the data for the profile (for example, company

phone list, and so on).

To use a profile for the first-time HotSync operation on Windows:
1. Place the new RDA in the cradle.
2. Press the HotSync button on the cradle.
3. Click Profiles.
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4. Select the profile that you want to load on the RDA, and click OK.
5. Click Yes to transfer all the profile data to the RDA.

Selecting HotSync setup options

You can choose when you want HotSync Manager to run. If necessary, you can adjust the local and
modem HotSync settings as well.

To set the HotSync options on Windows:
1. Click the HotSync Manager icon in the Windows system tray.
2. Choose Setup.
3. Click the General tab, and select one of the following options:

· Always Available adds HotSync Manager to the Startup folder and constantly monitors the
communication port for synchronization requests from your RDA. With this option, the
HotSync Manager synchronizes data even when Palm Desktop is not running.

· Available Only When Palm Desktop Is Running starts HotSync Manager and monitors requests
automatically when you open Palm Desktop.

· Manual monitors requests only when you select HotSync Manager from the Start menu.

If you're not sure which option to use, keep the default setting, Always Available.

4. Click the Local tab to display the settings for the connection between your computer and the
RDA cradle or communications cable.
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5. If necessary, choose another Serial Port to identify the port that Palm Desktop uses to
communicate with the cradle. This selection should match the number of the port to which you
connected the cradle. Your RDA cannot share this port with an internal modem or other device.
See "Meazura™ MEZ1000 components" in chapter 1 if you have trouble identifying the serial
port.

6. If necessary, set the speed to determine the speed at which data is transferred between your
RDA and Palm Desktop.

7. Try the As Fast As Possible rate first, and adjust downward if you experience problems. This
setting allows Palm Desktop and your RDA to find and use the fastest speed.

8. Click OK.

Customizing HotSync application settings

For each application, you can define a set of options that determines how records are handled during
synchronization. These options are called a "conduit." By default, a HotSync operation synchronizes
all files between the RDA and Palm Desktop.

In general, you should leave the settings to synchronize all files. The only reason you might want to
change these settings is to overwrite data on either your RDA or Palm Desktop, or to avoid
synchronizing a particular type of file because you don't use it.

In addition to the conduits for Date Book, Address Book, To Do List, and Memo Pad, Palm Desktop
includes System and Install conduits. The System conduit backs up the system information stored on
your RDA, including Graffiti® 2 ShortCuts. The Install conduit installs applications on your RDA.

To customize HotSync application settings on Windows:
1. Click the HotSync icon in the Windows system tray (bottom right corner of the taskbar).

TIP
You can also click the HotSync command on the Palm Desktop menu bar.

2. From the HotSync Manager menu, choose Custom.

3. Select the appropriate user name from the list.
4. Select an application in the Conduit list. Click Change.
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5. Click the direction in which you want to write data, or click Do Nothing to skip data transfer for
an application.

6. Choose how long the setting will remain in effect:
· To have the setting affect only the next HotSync operation, deselect Set As Default.

Thereafter, the HotSync Actions revert to their default settings.
· To use a new setting as the default, select the Set As Default option. Thereafter, whatever

you selected as the default setting is used when you click the Default button in the Custom
dialog.

7. Click OK.
8. Repeat steps 4 through 7 to change conduit settings for other applications.
9. Click Done to activate your settings.

Using File Link (Windows only)

The File Link feature lets you import Address Book and Memo Pad information into your RDA from a
separate external file such as a company phone list. HotSync Manager stores the data in a separate
category on your Palm Desktop and your RDA. You can set the File Link feature to check for changes
to the external file when you perform a HotSync operation.

With File Link, you can import data stored in any of the following file formats:
· Comma delimited (.csv).
· Tab delimited (.tsv).
· Memo Pad archive (.mpa).
· Address Book archive (.aba).
· Text (.txt).
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Part X
Maintaining Your RDA

It is important to maintain your RDA.

The Meazura™ MEZ1000 RDA is dustproof and waterproof to IP67 standards, but it must be kept as
clean as possible. This will help avoid possible accidents occuring or damage being done to the
Meazura™ MEZ1000, especially when connecting or operating the RDA near other electrical
equipment.

Always keep the RDA free from hazardous substances, dirt, debris, and submergence in liquid.

A list of recommended practises for maintaining the RDA are covered in this chapter along with thoses
that should be avoided.

Environmental Factors

Storage Conditions
Store the RDA in a cool dry place.

Operating Conditions
While operating the RDA please ensure it is free of moisture, particularly when operating around
electrical equipment. The Meazura™ MEZ1000 is waterproof and dustproof to IP67 standards and can
be operated in most environmental conditions. We do not however, recommend the RDA be operated
in extreme conditions (e.g. Underwater for long periods, in extreme hot and cold environments, or at
extreme altitude).

Avoiding Hazardous Substances

The plastic case of the Meazura™ MEZ1000 is made of a Bayer Bayblend FR2000. At room
temperature, the RDA is resistant to mineral acids, a large number of organic acids and aqueous
saline solutions. The Meazura™ MEZ1000 is not resistant to bases, aromatics, ketones, esters,
chlorinated hydrocarbons and  some greases and oils.

Bayblend FR 2000 is noted for the properties, of toughness, stiffness, heat resistance and is flame
retardant.

Cleaning your RDA

When removing mud and other debris from the Meazura™ MEZ1000, use a damp cloth and a soft
bristle brush and completely dry the Meazura™ MEZ1000 before using.

WARNING
For safety reasons, ensure the RDA is completely dry before charging and operating near electrical
equipment.
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Maintaining your Battery Pack

Battery Usage
The Meazura™ MEZ1000 RDA comes with a custom rechargeable Lithium Ion battery pack that can
only be purchased from Aceeca or participating resellers. The battery pack allows about 60 hours of
continual use.

Battery Warnings
· Do not heat or throw the battery into a fire.
· Do not use or store the battery close to fire or inside a car in which the temperature may be over

60°C.
· Do not put the battery in your pocket or in a bag together with metal objects such as necklaces,

hairpins, coins, or screws. Do not store the battery with such objects.
· Do not short circuit the (+) and (-) terminals with a metal object such as a needle, necklace or

hairpin.
· Do not pierce the battery with a sharp object such as a nail.
· Do not hit with a hammer, step on, throw, drop or allow the battery to undergo other such strong

shock.
· Do not disassemble or modify the battery.
· Do not solder the battery directly.
· Do not use a battery that is severely scarred or deformed.

Battery Storage
Unlike NiCad (Nickel Cadium) batteries or NiMH (Nickel-metal Hydride) batteries, lithium-ion batteries
should be charged early and often. When not in a device the battery should be kept at charge level of
around 40%.

Never use battery maintenance software to maintain your battery as this can reduce the life of your
battery.

Li-ion batteries should be kept cool. Ideally stored in a refrigerator. They should not be subjected to
freezing temperatures. Aging will occur much faster at high temperatures (such as a hot car) and will
reduce the life of your battery.

Purchase a Li-Ion battery pack only when you need a replacement, ensuring you receive a fresh
battery pack.

· Do not use the battery with dry cells or other primary batteries, or batteries of a different package,
type, or brand.

· Stop using the battery if it exhibits abnormal heat, odor, color, deformation or is in an abnormal
condition.

· Keep away from fire immediately when leakage or foul odor is detected.
· If liquid leaks onto your skin or clothes, wash well with fresh water immediately.
· If liquid leaking from the battery gets into your eyes, do not rub your eyes. Wash them well with

clean water and consult a doctor immediately.
· Before using the battery, be sure to read the user's manual and cautions on handling thoroughly.
· For information on installing and removing the battery from equipment, thoroughly read the user's

manual for the specific equipment.
· Batteries have life cycles, so if the time that the battery is powering the equipment becomes much

shorter than usual, the battery life is at an end. Replace the battery with a new one.
· Remove a battery whose life cycle has expired from equipment immediately.
· When the battery is discarded, make it non-conducting by applying vinyl tape to the (+) and (-)

terminals. The battery must either be discarded as specified by the relevant local body or put it in
the recycling box of a store that is cooperating in the recycling of rechargeable batteries.

· When not using the battery for an extended period, remove it from the equipment and store it in a
place with a low humidity and low temperature.
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· If the terminals of the battery become dirty, wipe them with a dry cloth before using the battery.
· The battery can be stored within a -20°C to 40°C temperature range.

Battery Charging
The lithium-ion battery can provide between 300-500 charge/discharge cycles.

The lithium-ion battery is certainly different from most other rechargeable batteries as charging from
a partially charged battery keeps the battery in great condition whereas other batteries prefer to be
fully discharged each time before recharging again. Fully discharging the lithium-ion battery should
be avoided wherever possible. For most users, charging the battery at the end of each day would be
the ideal choice.

The lithium-ion battery pack typically lasts about 2-3 years, but potentially longer if cared for in the
right way.

· When charging the battery, use dedicated chargers and follow the specified conditions.
· Do not use or charge the battery close to fire or inside a car in which the temperature may exceed

60°C.
· Stop charging the battery if charging is not completed within the specified time.
· Thoroughly read the user's manual for the charger before charging the battery.
· The battery can be charged within a 0°C to 45°C temperature range.
· Use the battery only in the specified equipment.
· Do not charge the battery in a place where static electricity is generated, or let the battery touch

something that is statically charged.

Recycle and Disposal Methods
Lithium ion batteries, like all rechargeable batteries are recyclable and should be recycled.

CAUTION
If your battery is damaged, or if it no longer holds a charge, dispose of it promptly and properly.
Do not dispose of it along with general waste. Call your local waste disposal agency or
environmental agency for advice on disposing of the battery.

Removal and Re-installation of Modules

When your Meazura™ MEZ1000 RDA leaves the factory, the module screws are tightened to a specific
torque setting to ensure the Meazura™ MEZ1000 is sealed to IP67 standards. However if you do
decide to remove and re-insert the module, then to keep the Meazura™ sealed to IP67 standards, the
module screws should be tightened to 40c2nm (or hand tight).

NOTE
Once you have personally removed the module from the Meazura™ MEZ1000 RDA, then your
warranty is voided. You can however request that Aceeca or approved distributors re-insert the
module for you to keep your warranty valid.

Refurbishment Services

Aceeca offers refurbishment services for your RDA. The types of services that exist are;
· Replacement of touchscreen
· Replacement of gaskets and keypad
· Refitting of module
· Refurbishment of damaged exterior
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For more information about the refurbishment process, please contact Aceeca through our website at
http://www.aceeca.com.

http://www.aceeca.com
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